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Copyrights
The information in this document is subject to change without notice and should not
be construed as a commitment by ABB Oy. ABB Oy assumes no responsibility for
any errors that may appear in this document.

In no event shall ABB Oy be liable for direct, indirect, special, incidental or
consequential damages of any nature or kind arising from the use of this document,
nor shall ABB Oy be liable for incidental or consequential damages arising from
use of any software or hardware described in this document.

This document and parts thereof must not be reproduced or copied without written
permission from ABB Oy, and the contents thereof must not be imparted to a third
party nor used for any unauthorized purpose.

The software or hardware described in this document is furnished under a license
and may be used, copied, or disclosed only in accordance with the terms of such
license.

© Copyright 2009 ABB Oy

All rights reserved.

Trademarks

ABB is a registered trademark of ABB Group. All other brand or product names
mentioned in this document may be trademarks or registered trademarks of their
respective holders.

Guarantee

Please inquire about the terms of guarantee from your nearest ABB representative.
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1. Introduction

1.1. This manual

This manual provides thorough information on the SPA-ZC 402 Ethernet Adapter
and the central concepts related to it. SPA-ZC 402 Ethernet is used for connecting
any Intelligent Electronic Devices (IED), which provides fibre-optic SPA bus, to the
IEC 61850 Station bus. In the manual you find information on SPA-ZC 402 and its
components, an introduction to engineering tasks and a description of the basic
operations.

The information in this manual is intended for application engineers, who install and
configure SPA-ZC 402. As a prerequisite, you should have basic knowledge of
IEC 61850 client and server architectures in general.

The IEC 61850 standards are available on IEC's web site (http://www.iec.ch).

1.2. Use of symbols

This publication includes the following icons that point out safety-related conditions
or other important information:

The electrical warning icon indicates the presence of a hazard which
could result in electrical shock.

The caution icon indicates important information or warning related to
the concept discussed in the text. It might indicate the presence of a
hazard which could result in corruption of software or damage to
equipment or property.

The information icon alerts the reader to relevant facts and conditions.

The tip icon indicates advice on, for example, how to design your
project or how to use a certain function.

It should be understood that operation of damaged equipment could, under certain
operational conditions, result in degraded process performance leading to
information or property loss. Therefore, comply fully with all notices.

1.3. Intended audience

This manual is intended for installation personnel, administrators and skilled
operators to support installation of the software.
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1.4. Product documentation

Name of the manual Document ID

SPA-ZC 402 configuration CD 1MRS151049

CAP 505 User's Guide 1MRS752292-MUM

SPA-ZF Optical glass fibres, multimode granded
index type

1MRS755371

Plastic-core fibre-optic cables, Features and
instructions for mounting

1MRS752089

Connectivity Packages, User's Guide

The Connectivity Packages can be
downloaded on the ABB web site
http://www.abb.com/
substationautomation.

1MRS755312

Related IEC 61850 standards:

* IEC 61850-6: Configuration description language for communication in
electrical substations related to IEDs

* IEC 61850-7-2: Basic communication structure for substation and feeder
equipment - Abstract communication service interface (ACSI)

* IEC 61850-7-3: Basic communication structure for substation and feeder
equipment - Common data classes

* IEC 61850-7-4: Basic communication structure for substation and feeder
equipment - Compatible logical node classes and data classes

* IEC 61850-8-1: Specific Communication Service Mapping (SCSM) - Mappings
to MMS (ISO 9506-1 and ISO 9506-2) and to ISO/IEC 8802-3

Visit also the International Users Group (UCA) web page for more information
about the IEC 61850 standard.

1.5. Document conventions

The following conventions are used for the presentation of material:

* The words in names of screen elements (for example, the title in the title bar of a
dialog, the label for a field of a dialog box) are initially capitalized.

* Capital letters are used for the name of a keyboard key if it is labeled on the
keyboard. For example, press the CTRL key. Although the Enter and Shift keys
are not labeled they are written in capital letters, e.g. press ENTER.

* Lowercase letters are used for the name of a keyboard key that is not labeled on
the keyboard. For example, the space bar, comma key and so on.

* Press CTRL+C indicates that you must hold down the CTRL key while pressing
the C key (to copy a selected object in this case).

* Press ALT E C indicates that you press and release each key in sequence (to copy
a selected object in this case).

* The names of push and toggle buttons are boldfaced. For example, click OK.
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* The names of menus and menu items are boldfaced. For example, the File menu.
* The following convention is used for menu operations: Menu Name > Menu

Item > Cascaded Menu Item. For example: select File > Open > New Project.
* The Start menu name always refers to the Start menu on the Windows Task Bar.
* System prompts/messages and user responses/input are shown in the Courier

font. For example, if you enter a value out of range, the following message is
displayed: Entered value is not valid.

You may be told to enter the string MIF349 in a field. The string is shown as
follows in the procedure: MIF349

* Variables are shown using lowercase letters: sequence name

1.6. Revision history

Version Date History

A 23.11.2004 Document created

B 30.12.2004 Ordering information updated

C 31.01.2005 Table 8.2.-2 Surge immunity updated

D 30.06.2006 SPA-ZC 402 2.0 additions

E 16.2.2007 SPA-ZC 402 2.1 additions

F 20.05.2009 SPA-ZC 402 2.1.2 additions
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2. Safety information

Non-observance can result in death, personal injury or substantial
property damage.

Only a competent electrician is allowed to carry out the electrical
installation.

National and local electrical safety regulations must always be
followed.

The device contains components which are sensitive to electrostatic
discharge. Unnecessary touching of electronic components must
therefore be avoided.
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3. Quick start
1. Install Communication Engineering Tool (CET) for SPA-ZC 40x and

Connectivity Packages.

Download the latest Connectivity Packages on the ABB web site
http://www.abb.com/substationautomation.

2. Activate the appropriate Connectivity Package by using Connectivity Package
Manager, see Fig. 3.-1.

A060282

Fig. 3.-1 Connectivity Package Manager

3. Create a new project by selecting File > Open/Manage Project from CET for
SPA-ZC 40x.

4. Install a new IEC 61850 device (SPA-ZC 40x) by right-clicking the project and
selecting New > IEC61850 > SPA-ZC 40x (SPAZC40x_v1x is for the previous
version).
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5. Install a new IED by right-clicking the IEC 61850 device and selecting New >
Communication. Select the appropriate IED type and rename the IED with the
unique name.

Each IEC 61850 name has to be unique in each level (IED, LD, LN,
DO).

If you wish to import the existing IEC 61850 device CID file to the device, select
Logical Device and import the CID file to it.

6. Import the IED application to logical device LD1 by right-clicking LD1 and
selecting the AR file, which contains the IED application.

7. Set the IP address to SPA-ZC 40x in Object Properties panel.
* Default Gateway
* IP Address
* SNTP Server 1 and 2
* Subnet mask

Refer to Section 5.5.1. Changing computer's IP address.

8. Set Time Zone Correction.

9. Rename the IED, for example REF545_F1.

10.Adjust IED SPA Communication parameters in the Object Properties panel.

11.Adjust network adapter's IP address to same subnet as SPA-ZC 402. To perform
the operation, open Windows XP Network Connections in Control Panel.

If CID file exists, the IP address is read from the file. Otherwise, the default IP
address of SPA-ZC 402 is 192.168.2.10.

Use IP Query Tool to find out an unknown IP address.

12.Use CID Export tool to transfer the configuration file to SPA-ZC 40x.

13.Export CID or ICD file for the IEC 61850 client.
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4. Product overview
SPA-ZC 402 is used to connect one IED with the fibre-optic SPA bus to the
IEC 61850 Station bus. The IEC 61850 standard defines the IEC 61850
communication and engineering specifications. SPA-ZC 402 offers also the
possibility to access the device with the SPA protocol over the TCP/IP network
using the same Ethernet link.

REF 542plus

COM600

A060239

Fig. 4.-1 Conceptual picture of a typical system setup

It is not allowed to connect multiple SPA devices to SPA-ZC 402 in the
SPA loop because of performance reasons. If SPA-ZC 402 is an
integral part of a bigger rack, for example of a SPACOM 300 series
rack, configure all devices under the same SPA-ZC 402. The
SPACOM 300 series rack is one SPA device.

The mechanical and electrical connection of the Ethernet adapter to an IED interface
is described in Section 5. Installation. The Ethernet adapter programming is
described in Section 6. Engineering.

It is a prerequisite to understand the communication properties of Intelligent
Electronic Devices (IED) before connecting to the Ethernet adapter. This
information is available in the manual for the protection relay in question. It is also
necessary to have basic understanding of the IEC 61850 system to which the IEDs
will be connected.

ABB has tested the following third-party devices, which are recommended to be
used with SPA-ZC 402:

Industrial 10/100 MBit switches:

* RuggedCom RS800
* RuggedCom RS1600
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* RuggedCom RSG2100
* Westermo FST208

Media converters:

* RuggedCom RMC-100-MM
* IMC McBasic MM1300
* Allied Telesyn AT-MC302-20

More tested devices can be found on the ABB web site
http://www.abb.com/substationautomation.

4.1. Features

SPA-ZC 402 has the following features:

* IEC 61850 connectivity for IED with fibre optic SPA bus
* Auxiliary power supply
* Easy-to-use configuration tool for the IEC 61850 data mapping
* Support of communication over TCP/IP

All relay data can be routed through SPA-ZC 402. The process data (status,
measurements and commands) is routed through the IEC 61850 bus and the rest of
the available data can be routed through SPA over TCP/IP.

Only one SPA client can be configured to poll SPA events from the
device. By default SPA-ZC 402 is configured to poll SPA events, then
it is not allowed to poll SPA events from another SPA client.

If the parallel IEC 61850 communication is configured for
RE_ 541/3/5 with two SPA-ZC 40x gateways, SPA event polls have to
be disabled in another gateway.

If the parallel IEC 61850 communication is configured for RE_ 541/3/5 with two
SPA-ZC 402 gateways, SPA event polls has to be disabled in another gateway.
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Fig. 4.1.-1 Parts of SPA-ZC 402

1 Ethernet connector
2 Fibre-optic SPA bus connectors
3 Auxiliary power supply connector
4 SPA TX and RX LEDs
5 LAN and diagnostics LEDs

4.2. IEC 61850 standard

The IEC 61850 standard is a comprehensive and durable standard, which defines the
communication between Intelligent Electronic Devices (IED) in substations. It is not
dependent on any application and offers one protocol which answers to all
requirements in substation. The configuration of the protocol is flexible. When
using the IEC 61850 standard, it is possible to allocate the functions and integrate
the functionality freely.

The IEC 61850 standard supports the following functions:

* Protection and control
* Integration of innovative sensor and switch technologies
* Metering, supervisory control and data acquisition (SCADA)
* Remote monitoring and fault diagnostics
* Automated dispatch and control
* Asset management
* Condition monitoring and diagnostics
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The IEC 61850 standard provides:

* Standardized information models for all kinds of protection relays, controllers,
circuit-breakers, transformers, and so on.

* Information exchange methods to access the information models' data: report
sequences-of-events, log historical data, control devices, sampled value
distribution, fast peer-to-peer process data exchange, and so on.

* A unified system configuration language (XML-based) and device online self-
description.

Compared to other communication standards for substation automation, the
IEC 61850 standard defines data modeling and communication services for this
specific domain. Data modeling is mapped to a communication protocol,
Manufacturing Message Specification (MMS, ISO 9506 protocol), which uses TCP/
IP and Ethernet. In addition to the communication specifications, engineering
information exchange is defined in Substation Configuration Language (SCL),
which is an XML based language. SCL ensures that IEC 61850 compatible IEDs
can be integrated in one system. For more information on the IEC 61850 standard
documentation, see Section 1.4. Product documentation.
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5. Installation
This chapter describes the installation of the SPA-ZC 402 module and the
Communication Engineering Tool (CET) for SPA-ZC 40x. For additional
information, such as technical data, maintenance and service, refer to Section 8.
Technical data and Section 9. Maintenance and service.

5.1. Mechanical installation

Screw the SPA-ZC 402 module on the cubicle's bottom or wall near the protection
relay. Pay attention to the length of the fibre-optic SPA cable when you are installing
the SPA-ZC 402 module.

5.2. Installing communication cable

Connect the fibre-optic SPA bus cable between IED and SPA-ZC 402. Connect the
LAN cable to the LAN connector of SPA-ZC 402. The other end of the cable is
connected to the IEC 61850-8 station bus through the Ethernet switch.

5.2.1. Auxiliary power connection

Voltage range for the external power connection (Uaux) is

* 110-220 VDC, 100-240 VAC or
* 24-60 VDC

Table 5.2.1.-1 Screw terminal of Uaux connection

Screw terminal AC DC

1 L +

2 N -

In addition there is an earthing screw for the protective earth conductor beside the
screw terminals in the casing.

5.3. Communication Engineering Tool for SPA-ZC 40x

5.3.1. System requirements

Communication Engineering Tool (CET) for SPA-ZC 40x runs on Windows 2000,
Windows XP and Windows Server 2003 operating systems. A PC capable of
running one of these operating systems is sufficient also for CET for SPA-ZC 40x.
For more information, refer to Section 1.4. Product documentation. The detailed
system requirements can be seen below.

* 20 MB free hard disk space if Microsoft .NET Framework 1.1, which is required
for running CET for SPA-ZC 40x, has already been installed.

* 100 MB free hard disk space, if the Microsoft .NET Framework 1.1 is not
installed. It is installed automatically if it is not found.
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5.3.2. Installing Communication Engineering Tool for SPA-ZC 40x

1. Uninstall the previous version.

2. Close all the open programs and insert the Communication Engineering Tool
(CET) for SPA-ZC 40x installation CD to the CD-ROM drive of your PC.

3. The Installation program starts automatically. If this is not the case, open the
program by starting setup.exe on the CD drive.

4. The installation wizard extracts the installation files to your local computer.

5. The CET for SPA-ZC 40x Installation program starts. In this dialog, click Next.
* With the Back button you can return to the previous dialog, and with the

Cancel button, exit the installation wizard. This applies to all the dialogs in
the installation wizard.

6. Read the License Agreement, select the option I accept the license agreement
and click Next to continue the installation.
* If the option I do not accept the license agreement is selected, the Next

button is not available and you cannot continue the installation.

7. Select the folder in which the application is to be installed.
* To select the default folder shown at the bottom of the dialog, click Next.
* To select another folder, click Browse, choose the folder you want and click

Next.

8. Both manuals are installed by default on your local hard drive. Click Next to
continue the installation.
* To install a manual, click the respective manual and select Will be installed

on local hard drive.
* To install the documentation feature, click the respective manual and select

Entire feature will be installed on local hard drive.
* To install the manual when required, click the respective manual and select

Feature will be installed when required.
* Not to install the manual, click the respective manual and select Entire

feature will be unavailable.

9. Click Next to begin the installation.

10.Follow the progress of the installation in a dialog that also shows the directory
path where the files are copied. At this point, you can still cancel the installation
by clicking Cancel.

11.A dialog opens to show that the tool has been successfully installed. Close the
dialog and finish the installation by clicking Finish.

12.When clicking Finish, the wizard also installs the Microsoft SQL Server
automatically, if it is not installed already.

13.Start CET for SPA-ZC 40x by selecting Start > Programs > Communication
Engineering Tool for SPA-ZC 40x > Communication Engineering Tool.

After installing a new CET for SPA-ZC 40x version or new
Connectivity Packages, always activate the correct Connectivity
Package version again by using the Connectivity Package Manager.
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5.3.3. Uninstalling Communication Engineering Tool for SPA-ZC 40x

1. Open the Add or Remove Programs dialog by selecting Start > Settings >
Control Panel > Add or Remove Programs.

2. Select Communication Engineering Tool (CET) for SPA-ZC 40x and click
Remove.

Uninstall CET for SPA-ZC 40x in order to install a new version and to
update the software. Uninstallation does not remove the Microsoft
SQL Server and .NET Framework. Removing these programs can
affect the functionality of the other ABB applications.

Detailed instructions for upgrading the software are provided when the
upgrade is available.

5.4. Installing Connectivity Packages

1. Close all the open programs and insert the SPA-ZC 402 configuration CD to the
CD-ROM drive of your PC.

The Connectivity Packages can be downloaded on the ABB web site
http://www.abb.com/substationautomation.

Contact ABB to check the connectivity package's status for the
Intelligent Electronic Device (IED) in question.

2. Double-click the Connectivity Package installation program and select the
relevant IED (.msi) to start the installation.

Install the Connectivity Package after installing the Communication
Engineering Tool (CET) for SPA-ZC 40x, see Section 5.3.2. Installing
Communication Engineering Tool for SPA-ZC 40x. If this is not the
case, re-install the Connectivity Package after installing the CET for
SPA-ZC 40x.

3. The installation wizard extracts the installation files to your local computer.
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4. The Connectivity Package Installation program starts. In this dialog, click Next.
* With the Back button return to the previous dialog, and with the Cancel

button, exit the installation wizard. This applies to all the dialogs in the
installation wizard.

5. Read the License Agreement, select the option I accept the license agreement
and click Next to continue the installation.
* If the option I do not accept the license agreement is selected, the Next

button is not available and you cannot continue the installation.

6. Select the folder in which the application is to be installed.
* To select the default folder shown at the bottom of the dialog, click Next.
* To select another folder, click Browse, choose the folder you want and click

Next.

7. Click Next to begin the installation.

8. Follow the progress of the installation in a dialog, which also shows the directory
path where the files are copied to. At this point, you can still cancel the
installation by clicking Cancel.

9. A dialog opens to show that the Connectivity Package has been successfully
installed. Close the dialog and finish the installation by clicking Finish.

After installing a new CET for SPA-ZC 40x version or new
Connectivity Packages, always activate the correct Connectivity
Package version again by using the Connectivity Package Manager.

5.4.1. Enabling Connectivity Packages

Use Connectivity Package Manager to enable the Connectivity Packages for
SPA-ZC 402.

Only one version of each Connectivity Package can be enabled at a
time.

1. Double-click the icon on the computer's desktop to start the
Connectivity Package Manager.

2. Select the corresponding Connectivity Package to enable it for SPA-ZC 402.

3. Click OK to apply the selection, see Fig. 5.4.1.-1.
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A060282

Fig. 5.4.1.-1 Connectivity Package Manager

5.4.2. Uninstalling Connectivity Packages

1. Open the Add or Remove Programs dialog by selecting Start > Settings >
Control Panel > Add or Remove Programs.

2. Select the relevant Connectivity Package and click Remove.

5.5. Connecting to SPA-ZC 402

The Sections 5.5.1. and 5.5.2. describe how to connect to SPA-ZC 402 from the
Communication Engineering Tool (CET) for SPA-ZC 40x.

5.5.1. Changing computer's IP address

To connect SPA-ZC 402, the used computer and SPA-ZC 402 must use the same
address space.

To change the computer's IP address space to be the same as in SPA-ZC 402:
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1. Open the Network Connections in Control Panel.

2. Type, for example, the following IP address to the IP address box: 192.168.2.1.
See Fig. 5.5.1.-1.

You must have system administration rights to perform the task.

A060241

Fig. 5.5.1.-1 Changing IP address

5.5.2. Checking connection to SPA-ZC 402

Check the connection to SPA-ZC 402 by using the ping command:

1. Open the Run dialog.

2. Type cmd to the Open box, see Fig. 5.5.2.-1.
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A060242

Fig. 5.5.2.-1 Starting command prompt

3. Click OK to run the command prompt.

4. Type ping 192.168.2.10, see Fig. 5.5.2.-2.

Fig. 5.5.2.-2 Pinging SPA-ZC 402

SPA-ZC 402responds to the ping command if the computer and SPA-ZC 402 are
on the same network.

5. If SPA-ZC 402 responds with the IP address, the connection is established
between the computer and SPA-ZC 402.

SPA/ Ethernet Adapter

SPA to IEC 61850 Gateway
Installation and Commissioning Manual

SPA-ZC 402SPA-ZC 4021MRS755380



28



29

6. Engineering
This section guides when performing the engineering tasks required before using
SPA-ZC 402.

For more information on the IEC 61850 data modeling, refer to the IEC 61850
standards listed in Section 1.4. Product documentation.

Note that all the possible engineering scenarios are not included in this
manual. You must have engineering rights to be able to perform the
tasks described in this section.

6.1. Overview of engineering

The engineering and maintenance of SPA-ZC 402 is done by using CET for
SPA-ZC 40x functions or by importing the existing SPA-ZC 40x CID file. The
device's communication structure is described in the Project Explorer dialog. The
structure is built by using device objects. These objects have communication
properties that can be accessed through the Object Properties dialog. These
properties define for example the IP addresses, unit addresses, and descriptions.

The process data accessible on devices is modeled according to the IEC 61850
standard. The communication structure consists of:

* Logical devices (LD)
* Logical nodes (LN)
* Data objects (DO)
* Data attributes (DA)

The data model is imported from the preconfigured object types of devices, which
have the objects defined and configured. These object types are defined in the
standardized IED Connectivity Packages. The data model can also be created
manually by using CET for SPA-ZC 40x functions.

When the structure is complete and all the objects have been set up properly, the
configuration is downloaded through FTP to SPA-ZC 402 by using the CID
(Configured IED Description) Export function.

The engineering tasks are the following:

1. Building an object tree according to the IEC 61850 data model by importing the
Connectivity Package or by adding the IEC 61850 data objects manually to the
configuration

2. Configuring object properties, for example adding mapping to the SPA
references in the IED (Intelligent Electronic Device)

3. Configuring IED TCP/IP addresses and parameters

4. Configuring SPA addresses and parameters

5. Exporting configuration data to SPA-ZC 402 and to the IEC 61850 system
configuration tool
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6.2. Creating project

You need to start the Communication Engineering Tool (CET) for SPA-ZC 40x to
open and name a project, see Fig. 6.2.-1 and Fig. 6.2.-2.

A040013B

Fig. 6.2.-1 Opening a project

A040014B

Fig. 6.2.-2 Creating a new project

6.3. Restarting

Use this function to restart the SPA-ZC 402 at runtime.

1. Select IED and Tools > Restart SPAZC40x to open the restart panel, see
Fig. 6.3.-1

2. Click Reset.

The results are reported to the UI text box.
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Do not use the restart function while downloading configuration to
SPA-ZC 402. When download is finished, SPA-ZC 402 is restarted
automatically.

A060396

Fig. 6.3.-1 Restarting

6.4. Building object tree

After installing the Connectivity Package you need to build and configure an object
tree in the Communication Engineering Tool (CET) for SPA-ZC 40x to define the
communication structure.

Fig. 6.4.-1 shows an example of the object tree when it has been built. In the
example tree you can see the SPA-ZC 402 object and its child objects as devices
and data objects. Indentation is used to indicate the parent-child relationship
between the objects.

SPA/ Ethernet Adapter

SPA to IEC 61850 Gateway
Installation and Commissioning Manual

SPA-ZC 402SPA-ZC 4021MRS755380



A040137B

Fig. 6.4.-1 Example view of the SPA-ZC 40x Communication Engineering Tool

Add objects to the object tree in the communication structure by right-clicking the
object to which you want to add a child object. Use LN and DOI wizards to create
new objects.

Add the objects in the following order:

1. IEC 61850 Device object (SPA-ZC 40x)

2. Logical Device objects

3. Logical Node objects

4. Data objects

5. Datasets

6. Reporting control blocks

7. GOOSE control blocks

8. GOOSE inputs
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6.4.1. Adding Device object

To build the object tree:

1. Add an IEC 61850 Device object in the communication structure by selecting the
project name.

2. Right-click Protocol Test

3. Select New > IEC 61850 > SPAZC40x_v2x, see Fig. 6.4.1.-1.

Normally, the SPAZC40x_v2x template from the menu is used. Only if the
connected SPA-ZC 402 is an older version 1.1.1, you have to select its own IED
template SPAZC40x_v1x from the menu. This is illustrated in the following figure.

A project can contain several IEC 61850 device objects, for example all substation
feeder configurations and exported communication must be done separately for each
device.

A040023_3

Fig. 6.4.1.-1 Adding an IEC 61850 Device object

Ensure that the new IED name is unique within the planned network by renaming
the IED, for example REF545_F1.

A Tunneling Device object cannot be configured for an IEC 61850
gateway.

The Logical Device LD0 describes SPA-ZC 402 and includes the data objects for
diagnostics and description. All data sets and report control blocks (RCB) are
collected to LLN0.

6.4.2. Adding Logical Device objects

Communication Engineering Tool (CET) creates logical device LD0 automatically
for SPA-ZC 402 when creating a new IED. All datasets and reporting control blocks
(RCB) are grouped under LD0 for event handling. It has also basic logical nodes
and data objects for diagnostics and device information.

Do not change the name of the LD0.
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Adding a new Logical Device object (for example REX 521, see Fig. 6.4.2.-1) is
possible only after you have installed Connectivity Packages to your computer. The
IED's data model behind SPA-ZC 402 is described in the logical device LD1.

For more information about installing Connectivity Packages, refer to Section 5.4.
Installing Connectivity Packages.

A040154

Fig. 6.4.2.-1 Adding Logical Device objects

The logical device object is now shown as a sub-object to the IEC 61850 Device
object, see Fig. 6.4.2.-2.

A040155

Fig. 6.4.2.-2 Logical node is shown as sub-object

You should have at least one Logical Device object as a child object to
each IEC 61850 Device Object.

You can have a maximum of seven Logical Device objects under one
Device Object (LD0 and six IED logical nodes).
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When the actual IEC 61850 data model is created, the logical device name has two
parts:

* Device Object name
* Logical Device name

For example, REF543_F1LD0.

6.4.3. Importing IEC 61850 data object model of IED

1. Right-click to select a Logical Device created in Section 6.4.2. Adding Logical
Device objects (for example, REX 521).

2. Import the data model by selecting the Generate Configuration function and by
choosing the right IED type.

The imported file, which is in the specified directory, is a compressed archive file
from CAP 505 Application Library with the file extension .AR.

Communication Engineering Tool (CET) for SPA-ZC 40x converts the project files
with the help of the Connectivity Packages to a IEC 61850 data object model.

The Connectivity Package does not necessarily support all the functions of IED. The
functions, which are not mapped to the IEC 61850 structure, are reported after
import.

The tool imports default data sets and report control blocks (RCB) to logical device
LD0, see Fig. 6.4.3.-1. Data sets include a set of selected data attributes from IED's
IEC 61850 data model. These data sets are used in the IEC 61850 event reporting
model. If data attributes are selected to the data set and the same data set is used in
report control block (RCB), the data set generates a spontaneous event which will be
sent to the IEC 61850 client. If the data set is not defined in the RCB, the IEC 61850
client reads the data separately. You can modify data sets with Dataset Editor tool,
see Section 6.5. Using Dataset Editor.

After adding a new relay, give the IED with the unique name in the
network. Space is not allowed on the IED's name. Renaming can be
done in the Project Explorer dialog, see Fig. 6.4.3.-1.
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Fig. 6.4.3.-1 Project Explorer dialog in the Communication Engineering Tool window

6.5. Using Dataset Editor

The dataset groups selected data so that a client can access it easily with a single
read operation. Dataset is also the basic part of event reporting; data is linked to
spontaneous event sending only via report control blocks (RCB) dataset definition.
The client reads other data separately. Datasets definitions are located always under
the logical device LD0 and logical node LLN0. The SPA-ZC 40x dataset maximum
length is 320 data attributes. The tool warns the user if the dataset is too long.

You can modify dataset by using Dataset Editor. Open Dataset Editor by selecting
the dataset and right-click to open Dataset Editor. Dataset has a set of data attributes:
logical device instance name, optional prefix, logical node instance name, logical
node class, data object name and functional constraint (FC).Functional constraint
divides data attributes to groups, which have the same functional constraint, under
the same data object. For example, functional constraint ST (status information)
groups stVal, q and t data attributes together, and then you do not have to add data
attributes one by one to the dataset. Data attributes are collected to the dataset in
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groups, and functional constraint defines the data attributes. This is MMS protocol's
naming feature, which is the basic part of naming and protocol definition in the
IEC 61850 standard.

Delete the dataset by selecting the line and either pressing DELETE or selecting
Edit > Delete function.

A040028

Fig. 6.5.-1 Dataset Editor

Dataset Editor columns:

* IdInst

Instance of Logical Device to which referenced dataset belongs

* Prefix

Freely configurable part of LN Caption

* InInst

Instance of the LN type

Class of the LN type

* InClass
* doName

Name of the data object from which dataset is formed

* daName

Name of the data attribute from which dataset is formed from

* fc

Identifies the signal measurement type to MX, if the status is ST

Prefix, InClass and InInst define the object tree's caption. Caption is shown in the
following way: Prefix + InClass + InInst = LN Caption.
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6.6. Configuring by using imported CID file

If you have to configure several SPA-ZC 402 with the similar IEC 61850 data object
model, it is possible to import a previously generated CID file and change the
communication addresses, typically by changing the IP address.

1. Create the project and add the logical device LD0 like in Section 6.4. Building
object tree.

2. Add a logical device to the SPA-ZC 40x Device object by right-clicking to select
SPA-ZC 40x > New > Communication > Logical Device.

3. Select the CID import function by choosing a new empty logical node and then
right-click to select the CID import function.

In the CID import dialog you can select the right CID file from the workstation
directory and import it to a previously created logical node. LD0 contains the data
sets and reporting control blocks. Other logical devices describe the data model of a
connected IED.

6.7. Configuring communication parameters

SPA-ZC 402 communication parameters are located in the device properties.
SPA-ZC 402 uses static IP addresses, which have to be defined in the planned
network structure.

* IP Address

IP address identifies SPA-ZC 402 in Local Area Network (LAN). All
communication via SPA-ZC 402 uses this address. The default value is
192.168.2.10 and it has to be changed to a unique address according to the
planned network structure.

* Default Gateway

This IP address defines the gateway's address, which forwards IP traffic between
the local subnet and outside world. The default value is 192.168.2.1 and it has to
be changed according to the planned network structure.

* Subnet Mask

This subnet mask defines which addresses are not in the local subnet and must be
accessed through the default gateway.

* SNTP Servers

SPA-ZC 402 uses SNTP for its own realtime clock. The time is used for
synchronizing the IED with SPA time synchronization. One SNTP Server has to
exist in the accessible network, otherwise the SPA-ZC 402 event time stamping
is not working properly. The primary server is mainly in use. The secondary
SNTP server is used, if the primary SNTP server cannot be reached. While using
the secondary SNTP server, SPA-ZC 402 tries to change to the primary server in
every third SNTP request attempt. The primary server is used, if the request is
succeeded.
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If both SNTP servers are offline, the event time stamps have the status:
ClockNotSynchronized. If at least one SNTP server is online, but the server’s
clock is not synchronized, the event time stamps have the status: ClockFailure. In
additon, when a time synchronization message is not received during the startup,
the time stamping starts at 00:00:00 01.01.1970. The time is requested from the
SNTP server every 60 seconds.

* Time Zone Correction

Due to the SNTP time synchronization, a time offset must be added to the SPA
time synchronization message depending on the time zone. It affects the IED
HMI event list. The value (in minutes) is between - 720 and 780 and it is
comparable to Coordinated Universal Time (UTC).

* OSI addresses are read-only and they are always the same. The IEC 61850 client
uses these addresses to access SPA-ZC 402 over MMS.

An established IEC61850 connection uses the TCP keepalive functionality, if there
is no other active communication ongoing. TCP keepalive is sent every 15 seconds.
If the peer is not responding, it is considered to be time-outed and the TCP
connection is closed.

Fig. 6.7.-1 General communication parameters

6.7.1. SPA Communication parameters

* SPA Address

SPA-ZC 402 needs also an IED SPA address to access the SPA data. Every
logical device has SPA Communication Parameters Object properties except
LD0, which describes the SPA-ZC 402. The SPA address object property has to
be the same as the configured SPA unit number in IED.

* SPA Password

SPA password is used for commands and it has to be the same as the defined
password in the IED. The password can be modified in the IED side with HMI or
a specific tool.
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SPA-ZC 402 has to know the SPA password to enable the control service with
the connected IED. This value is written to the SPA parameter 0V160. The SPA
password has to be the same as defined in IED MMI.

* Bit rate

The default value of the communication bit rate in the internal link between the
IED and SPA-ZC 402 is 9600. Other possible values are 1200, 2400, 4800,
19200 and 38400 bits/s. Used value has to be same as the configured value in
IED.

REF 541/3/5 3.5 has support for GOOSE horizontal communication. When
protocol 2 mode is adjusted to the IEC 61850 mode, the serial port speed is set to
38400 bits/s. In this mode the special SPA for horizontal communication is used
and it allows to use GOOSE.

* SPA time synchronization

SPA-ZC 402 has three different modes of the IED time synchronization. The
mode is selected from the logical device object describing the IED, for example
LD1.

* Enabled

This is the default operation mode. When the operation is selected, you can
synchronize SPA-ZC 402 with SNTP as it is defined in the IEC 61850-8-1
standard, and SPA-ZC 402 is also synchronizing IED over SPA.

* Disabled

In this mode, you can only synchronize SPA-ZC 402 with SNTP and IED has
a different source of time synchronization.

* Read from device if supported

When this operation mode is selected, the time for SPA-ZC 402 is read from
IED over SPA. SNTP is not in use and the IED gets time synchronization
from another source.

* SPA time synchronization parameter

The parameter describes the SPA parameter which SPA-ZC 402 uses when
reading the time from the IED. Parameter is used when the previous parameter
defines that the time source is IED. IED gets the time from external source.

* Event poll

If the parameter is disabled, SPA-ZC 402 does not poll events from IED and the
IEC 61850 events are based on a continuous data poll. This feature could be used
in systems where, for example the other REF 543 port is already used for the
SPA communication. By default, event polls are used.

If the event polling is disabled, the timestamp accuracy depends on the
IED configuration and the SPA bus speed.

* DR Upload
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When this parameter is enabled, SPA-ZC 40x uploads disturbance recording files
from the MEDREC function block to SPA-ZC 40x file system in COMTRADE
format. IEC 61850 client can get these files when it receives an event from the
RDRE logical node. This parameter is enabled by default and you should ensure
that your system has an IEC 61850 client that is capable to use the IEC 61850
File Transfer protocol. For example, CAP 505 and PCM600 use SPA over TCP
to upload the disturbance recording files. FTP is used by COM600 or RTU.

The parameter is valid with REF 541/3/5, REM 543/5, RET 541/3/5 and
REX 521.

A040022

Fig. 6.7.1.-1 SPA Communication Parameters

Locally, SPA-ZC 402 uses UTC (Coordinated Universal Time) time, which is
received from the SNTP time synchronization by default. This time format does not
use Daylight Saving Time. If you want that the IED and SPA communication uses
this time format, the IEC 61850 client has to be programmed to write the minute
offset of the UTC time to the LD0.LLN0. Daylight parameter at the defined date and
time depending on the location.

6.8. Downloading configuration and exporting CID file

After you have built the IEC 61850 data model and done the communication
addressing, you can download the configuration to SPA-ZC 402:
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1. Select the IEC 61850 Device object and right-click to select the CID Export.

2. If you download configuration to SPA-ZC 402 the first time, change the IP
address from default address (192.168.2.10) to new IP address according to the
planned network structure.

When the new configuration to SPA-ZC 402 is downloaded, Communication
Engineering Tool (CET) checks if the basic IP addresses are changed. If a change is
detected, CET asks whether new addresses are taken into use. If the changes are not
accepted, SPA-ZC 402 uses the old IP address from the previous configuration. The
IP addresses can be verified with, for example, IP Query Tool. For more information
about IP Query Tool, refer to Section 9.3. IP Query.

A040029B

Fig. 6.8.-1 Downloading the device's configuration

You can export a configuration in CID format from CID Export tool to hard drive.
This SCL is usually used by System Configuration tool. It is possible to export a
dataset in SCL files in different levels. If you select to export a dataset in FCD level,
for example an information report from SPA-ZC 40x contains always value quality
and time in one structure.
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You can also export the CID or ICD file to your workstation's file system and use it
in system level tools, for example to configure your IEC 61850 client.

6.8.1. IED application changes

If a new functionality is added to the IED application, the new IED application (AR
file) import is needed. In this case, there are two options:

* Communication Engineering Tool (CET) for SPA-ZC 402 asks either the old
SPA-ZC 402 application is overwritten or

* only the new functionality is added.

If the different logical nodes have the identical names in existing and in new
application, the logical nodes are overwritten.

6.9. Configuring by using IEC 61850 data model components

The IED model can be configured manually. You can start building the IEC 61850
data model by creating an empty logical device. For more information about adding
logical device, refer to Section 6.4.2. Adding Logical Device objects. The
IEC 61850 standard defines a mandatory logical node LLN0 for every device and its
objects. For best practice, check some ready projects based on Connectivity
Packages.

Adding and configuring logical nodes manually contains four main steps:

1. Add a logical node, for example CILO, for the circuit breaker objects with the
LN Wizard, see Fig. 6.9.-1.

2. Add data objects.

3. Configure the new logical node with the DO Wizard.

4. Define object properties to the data objects.

In more detail:

1. Select a logical node, for example LD1.

2. Right-click the logical node and select LN Wizard to start the LN Wizard, see
Fig. 6.9.-1. The LN wizard contains three text boxes: prefix, lnClass and lnInst.
Prefix and lninst are user-definable, while lnclass contains a list of logical nodes
that can be selected.

3. Type the appropriate information. The lnInst number has to be unique.

4. Click the Add LN button. The new logical node is added to the project.
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A040131B

Fig. 6.9.-1 LN wizard

5. Select the new logical node in the project tree.

6. Right-click the logical node and select DO Wizard to start the DO Wizard, see
Fig. 6.9.-2.

7. Select the DOType. Depending on the DOType selected, corresponding data
attributes are automatically added.

8. Type the DOI name.

9. Click Add DOI button for every data object you add.
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A040132B

Fig. 6.9.-2 DO Wizard

10.Start with the mandatory data objects and then add the process data. Mandatory
data objects are Mod, Beh, Health and NamPlt.

DO type DOI name

INC_diag Mod

INS_beh Beh

INS_health Health

LPL_simple NamPlt

INC_simple test

For more information about data objects refer to Section 11.2. Model
conformance statement.

11.Define properties to the data objects. In order to map the added IEC 61850 data
objects to the SPA data model, you have to define the properties for each data
object.

12.Right-click the data object to select Properties from the shortcut menu to
activate the Object Properties window.
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13.Select the data object again and right-click to start the DOI Editor. The Data
Object Instance Editor window is shown, see Fig. 6.9.-3.

14.Define the properties and SPA variable definitions for each data object in the
Object Properties window. The stVal field in the DOI editor is automatically
updated with the data entered in the Object Properties.

Follow the same procedure for all data objects that you have added to the LN
object.

A040133B

Fig. 6.9.-3 Data Object Instance Editor

The SPA point data is written to the sAddr in the CID file for the selected data
object. SPA-ZC 402 uses this field to poll data and events from the IED.

In order to get automatic updating of the process objects, you should
add those data objects of interest to the dataset group. Refer to
Section 6.5. Using Dataset Editor.
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6.10. Configuring report control blocks

Report control block (RCB) controls spontaneous event reporting. A client can
modify the report sending behavior by setting RCB attributes. The RCB attributes
have suitable default values for the following ABB products: COM600 and
MicroSCADA Pro IEC 61850 client. RCBs are located under the logical device
LD0 and logical node LLN0.
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Fig. 6.10.-1 Reporting model

RCB's have the following properties. To edit the properties, right-click the dataset
and select Properties.

* Buffered reporting

IEC 61850 buffers events also during a communication break. The same
buffering mechanism should be used by all the IED report control blocks.

* Buffer Time

The default value for buffered reporting is 100 milliseconds (ms). With this
value, RCB waits 100 ms for other events after the first change before sending
the report. Value 0 means that a new change is immediately reported to the client
without waiting for any additional changes. In practice, the buffer time can be
from 0 to a few seconds without a notable effect on the client's event notification
delays. The default values are suitable in most cases.

* Dataset

The Dataset property defines the data set to be sent as time tagged events with
buffered or unbuffered reporting. Notice that there are few restrictions in the IED
dataset usage to minimize the event load in the IEC 61850 station bus. One
dataset can be used only by one report control block. Additionally, different
datasets used for event reporting should not share the same data objects.

* Integrity Period

The default value for Integrity Period is 0 ms. If this attribute has a value > 0 ms,
SPA-ZC 402 sends a report with all data listed in a linked data set with this
period. By default, this feature is not enabled, because it generates an
unnecessary load to the server and network. If this feature is used, the properties
of Period Trigger Option in RCB need to be enabled.

* Report ID
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By default, this attribute is empty and SPA-ZC 402 uses it for RCB MMS
address. If this string is left empty, a default report control block MMS path
name is used.

* Option Field

Defines what information is sent with the report

By default, SPA-ZC 402 adds buffer over-flow information, a report entryID and
a sequence number, and allows segmentation. Other fields are the RCB
configuration version, data reference in MMS address format, the name of the
used data set and the report sending time.

* Max property

Defines how many clients are using this RCB, that is, the number of needed
RCB instances. If you define two clients for buffered reporting, Max has to be 2.
SPA-ZC 402 creates two instances of RCB name, for example, rcbStatNrml01
and rcbStatNrml02. For unbuffered reporting, Max has to be same as the number
of defined clients or higher. This is defined in the IEC 61850 standard.

* Trigger Options

Data Change, Data Update and Quality Change triggers are used by default
(changes in value and quality generates information reports). Period trigger is not
used by default.
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A040134B

Fig. 6.10.-2 Report Control Block

Buffered reporting needs mandatory Report Client definitions. Report Client
definitions link a certain RCB to a certain client. The client can import the CID file
to check which RCB instance it has to use. If the Max property is defined to 2, the
configuration must have two clients with buffered reporting. In the list, the client
who is defined first uses the first RCB instance (rcb name ...01) and the second RCB
uses second instance (rcb name ...02 ). It is not mandatory to define clients in
unbuffered reporting, but it is recommended for the sake of clarity. Client IED Name
has to match with the client name in Substation Configuration description Language
(SCL).

Every modification in the Dataset referenced in RCB increases the RCB
Configuration Revision property by one. The IEC 61850 client can verify the
deviations between the received configuration revision in the information report and
the imported configuration revision. If the configuration revisions do not match, the
client may discard the received information reports.
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6.11. Scales

To create a scale:

1. If a Scales object does not exist in the object tree, add the object by right-clicking
the project and selecting New > Communication > Generic ScaleGroup
Object or import a Connectivity Package or a CID file. If the Connectivity
Package or the CID file is imported, the Scales object is created automatically.

2. Right-click Scales in the Project Explorer pane and select New > Scales, see
Fig. 6.11.-1.

A060131

Fig. 6.11.-1 Adding a new scale

3. Select the Scales type: Look-up Table or Stepwise Linear

4. Configure the selected scale's properties, see Fig. 6.11.-2
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A060132

Fig. 6.11.-2 Configuring properties

5. Create reference to scale at DO level in object tree, see Fig. 6.11.-3
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Fig. 6.11.-3 Referring scale in DO

6.12. Using Disturbance Recorder files

In case of, for example, abnormal events on the electric line, the protection relay can
generate data for a graphical presentation of the detected phenomenon. These
presentations are stored by MEDREC16, the Disturbance Recorder function block
of the relay. When connected to a relay with the MEDREC16 version K or newer,
SPA-ZC 402 can load the recorded data and convert it to standard COMTRADE
files (in year 1999 format). The conversion is done automatically and the
Disturbance Recorder Ready signal is sent to IEC 61850 client after new files are
ready to be read.

A relay with compatible MEDREC16 function block notifies SPA-ZC 402 when it
has new recordings ready. SPA-ZC 402 reads the actual data from the relay as a
background process and stores the data as COMTRADE files in its own file system
under the directory C:\COMTRADE.
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When the IEC 61850 client has been notified of the incoming record, the client
should read the COMTRADE files from SPA-ZC 402 by using FTP or IEC 61850
File Transfer connection. The client must remove the files after successful reading to
maintain free space for forthcoming records. The files are named as follows:

File name Example Description

yymmddnn.cfg 70010104.cfg Configuration file

yymmddnn.dat 70010104.dat Data file

yymmddnn.inf 70010104.inf Information file

The filename consists of the following parts:

Part Format Description

yy 00 – 99 Record creation timestamp, year

mm 01 – 12 Record creation timestamp, month

dd 01 – 31 Record creation timestamp, date

nn 00 - 99 Running serial number of the records of the
same day. The Configuration, Data and
Information files related to one record have
the same serial number.

SPA/ Ethernet Adapter

SPA to IEC 61850 Gateway
Installation and Commissioning Manual

SPA-ZC 402SPA-ZC 4021MRS755380



54



55

7. Commissioning
The downloaded CID file is taken into use when SPA-ZC 402 is restarted
automatically.

Normally, the device is reset automatically after the configuration is downloaded
with Communication Engineering Tool (CET) for SPA-ZC 40x.

After downloading the configuration you can check the basic TCP/IP functionality
with the ping command in command prompt:

c:\>ping x.x.x.x.

The IEC 61850 communication is checked from the IEC 61850 client either by
using the exported CID or ICD file or by browsing the SPA-ZC 402IEC 61850
namespace.

You can see how the configuration process is progressing from the diagnostic LEDs.
When the SPA-ZC 402 configuration is completed, the green LED is on.

If SPA-ZC 402 is online with the IEC 61850 client, you can check the general
configuration status of SPA-ZC 402 from the data model LD0.LLN0.Health.stVal:

1. OK - configuration is completed successfully.

2. Warning - no clock synchronization.

3. Alarm - connection to the IED could not be established, or errors appear during
the data model configuration.

If the configuration fails, check the error log files from the SPA-ZC 402 file system.
The status and error logs are located in the /log directory. For more information
about maintenance, refer to Chapter 9. Maintenance and service.

7.1. Checking error situations on IEC61850

An internal relay fault (IRF) in REF 54x affects Health, Mod and Beh in all logical
nodes under LD1 in the following way:

* Mod.stVal gets the value 5 (Off)
* Beh.stVal gets the value 5 (Off)
* Health.stVal gets the value 3 (a severe problem, no operation possible)

Other devices may behave differently, depending on which SPA
parameters are connected to Mod, Beh and Health.
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Communication quality handling

* If there is a communication loss between IED and SPA-ZC 40x, all qualities get
the value 3 under LD1, including LD1.LLN0.Health.stVal = 3 (Error).

* In case of a time synchronization loss, LD0.LLN0.Health.stVal gets the value 2
(Warning).

* In case of an error in the configuration, LD0.LLN0.Health.stVal gets the value 3
(Alarm).

For more information, refer to Section 7. Commissioning

7.2. Checking SPA communication

If the configuration is completed successfully, you can check the resettable
diagnostic counters through the IEC 61850 data model.

SPA-ZC 402 Diagnostic counters are part of the LD0.CDGGIO1 logical node. The
data object type is ABB-specific extension in IEC 61850 data model and contains
the counters as data attributes. It is possible to reset the counters by writing 1 into
ctlVal. It is not recommended to put the counters into the data set because the
counter values are updated only during a read operation.

A040136

Fig. 7.2.-1 Diagnostic counters seen on MicroSCADA Pro IEC 61850 client
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The q attribute reflects the status of data. If the data is properly
updated, the data object's quality value is GOOD. If this is not the case,
configurations between SPA-ZC 402 and IED are not identical. If all
the data objects have INVALID quality, the SPA communication is not
running.
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8. Technical data

8.1. Interfaces

IED interface

* ST multimode glass fibre transmitter/receiver pair or
* Snap-in multimode plastic fibre transmitter/receiver pair

Ethernet interface

* LC fibre-optic multimode LAN connector
* MT-RJ fibre-optic multimode LAN connector
* RJ-45 (STP CAT5e) galvanic LAN connector

Optical fibres

* See fibre-optic guides:
* SPA-ZF Optical glass fibres, multimode graded index type
* Plastic-core fibre-optic cables, features and instructions for mounting

For more information, see Section 1.4. Product documentation.

Diagnostic LEDs

SPA-ZC 402 common diagnostic LEDs

* Power
* Diagnostic

* Red
* Green
* Yellow

LAN diagnostic LEDs

* LINK
* TX
* RX

SPA diagnostic LEDs

* TX
* RX
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Dimensions and weight
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Fig. 8.1.-1 Dimensions of the SPA-ZC 402 module

Table 8.1.-1 Dimensions and weight

Type Dimensions [mm] Weight [g]

SPA-ZC 402 190 x 115 x 35 510

8.2. Test and conditions

SPA-ZC 402 fulfills IEC 61850-3 Communication networks and systems in
substations.
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General requirements

Table 8.2.-1 Environmental test and conditions

Recommended service temperature range
(continuous)

-10...+55˚C

Limited temperature range (short-term) -40...+85˚C

Transport and storage temperature range -40...+70˚C according to the IEC 60068-2-48

Dry heat test According to the IEC 60068-2-2

Dry cold test According to the IEC IEC 60068-2-1

Damp heat test, cyclic According to the IEC 60068-2-30

Table 8.2.-2 Electromagnetic compatibility tests

EMC immunity test level meets the requirements listed below.

1 MHz burst disturbance test, class III According to the IEC 60255-22-1
* Common mode 2.5 kV
* Differential mode 1.0 kV

Electrostatic discharge test, class III According to the IEC 61000-4-2 and IEC 60255-22-
2

* For contact discharge 8 kV
* For air discharge Not applicable

Radio frequency interference tests
* Conducted, common mode According to the IEC 61000-4-6 and IEC 60255-22-

6 10 V (rms), f=150 kHz...80 MHz
* Radiated, amplitude-modulated According to the IEC 61000-4-3 and IEC 60255-22-

3 10 V/m (rms), f=80...2700 MHz
* Radiated, pulse-modulated According to the ENV 50204 and IEC 60255-22-3

10 V/m, f=900 MHz

Fast transient disturbance tests According to the IEC 60255-22-4 and IEC 61000-4-
4

* All terminals 4 kV

Surge immunity test According to the IEC 60255-22-5 and IEC 61000-4-
5

* Power supply, SPA-ZC402xxxA 4 kV line-to-earth, 2 kV line-to-line
* Power supply, SPA-ZC402xxxC 2 kV line-to-earth, 1 kV line-to-line
* RJ45-Cable 2 kV line-to-earth

Power frequency (50 Hz) magnetic field
IEC 61000-4-8

300 A/m continuous

Electromagnetic emission tests According to the EN 55011
* Conducted, RF-emission (Mains
terminal)

EN 55011, class A, IEC 60255-25

Radiated RF-emission EN 55011, class A, IEC 60255-25

CE approval Complies with the EMC directive 2004/108/EC and
the LV directive 2006/95/EC
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Table 8.2.-3 Standard tests

Mechanical tests

Vibration tests (sinusoidal) According to the IEC 60255-21-1, class I

Shock and bump test According to the IEC 60255-21-2, class I

Table 8.2.-4 Auxiliary power supplies

Type SPA-ZC 402 xxxA SPA-ZC 402 xxxC

Input voltage AC 110/120/220/240 V -

Input voltage DC 110/125/220 V 24/48/64 V

Voltage variation AC 85...110%, DC 80...120%
of rated value

DC 80...120% of rated value

Burden <4 W

Ripple in DC auxiliary voltage Max. 12% of the rated DC value (IEC 60255-11)

Interruption time in auxiliary DC
voltage without resetting

110 V <40 ms 24 V <24 ms
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9. Maintenance and service
If the SPA-ZC 402 module or a part of it is found to be faulty, the normal service
operation is to replace the entire module.

For more details, refer to Section 13. Ordering information.

9.1. LED indicators

Table 9.1.-1 LED indicators

LED Color State
Sequence
number

Description

Power Green On Power on

Link LAN Green On Indication for LAN link OK

RX LAN Green On Indication for incoming LAN traffic

TX LAN Green On Indication for outgoing LAN traffic

RX SPA Green On Indication for incoming SPA traffic

TX SPA Green On Indication for outgoing SPA traffic

DIAG Green Red Off
Flashing
On
Flashing
On
Off

On
On
On
Off
Off
Flashing

1
2
3
4
5
6

Bootloader booting
Bootloader, missing boot image
Starting
OK, missing configuration
OK, configuration in use
Configuration error

Possible sequences are:

1 → 3 → 5 Normal situation

1 → 2 Missing boot image

1 → 3 → 4 Configuration file is missing

1 → 3 → 6 Configuration error

If configuration error is detected because of the mismatches in
downloaded the CID file, download a simpler configuration. Check
also the log file in SPA-ZC 402.

9.2. Communication settings

SPA addresses in sAddr are not properly defined if

* Diagnostic counter SPAReplyTimo increases constantly and SPAReplyData
remains 0 in the LD0.CDGGIO1 logical node. These diagnostic counters are
readable from the IEC 61850 client.

* Quality of the data is INVALID.
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The following IED-specific settings have to be checked when setting up
REF 541/3/5, REM 543/5 or RET 541/3/5:

* SPA baud rate and SPA slave number in IED

Baud rate and slave number have to be according to the SPA-ZC 402 configuration
in X3.2/Communication 2.

9.3. IP Query

By using the IP Query Tool in Communication Engineering Tool (CET) for SPA-ZC
40x, it is possible to see all connected SPA-ZC 40x, devices, their communication
parameters and version information.

Example:

Sending IP query 1
RECEIVED MESSAGE FROM 10.58.125.151:
Mac Address: 00-0C-02-B0-04-89
Subnet Mask: 255.255.255.0
Default Gateway: 10.58.125.150
SNTP servers:10.58.125.150 127.0.0.1
SW_SPATYPE: SPA-ZC40x
SW_NUMBER: 1MRS118533
SW_BUILD: 110
SW_REVISION: B
Compiler DATE_TIME: Nov 28 2005 12:38:02

To use the IP Query Tool:

1. Select Tools > IP Query Tool to start the tool, see Fig. 9.3.-1.

Query activates devices from the network until it is stopped.

A060127

Fig. 9.3.-1 Starting the IP Query Tool

2. Select the Network adapter to send a query, see Fig. 9.3.-2.
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A060128

Fig. 9.3.-2 Selecting Network adapter

3. Click Start to start the query.

4. Click Stop to stop the query.

Connected devices are displayed in the Output pane, Fig. 9.3.-2.

Additional information depends on the SPA-ZC 40x version. If version 1.1.1 is
used, only MAC address is displayed. If version 2.0 is used, MAC address, other
address and revision information is displayed.

9.4. Identification

If contacting the Customer Service, it is necessary to send the following information
by request:

* Version of Connectivity Packages

The version can be checked from the Connectivity Package Manager.

* Version information of Communication Engineering Tool (CET) for SPA-ZC
40x
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Select Help > About to view the version information.

* SPA-ZC 402 version information

The version information can be read from the device's label. If the device is
updated afterwards, use CET's IP query to get the correct version information
from the device memory. For more information about IP query, refer to
Section 9.3. IP Query.

9.5. Obtaining error logs

The following session transfers error.log file through ftp.

C:\>ftp x.x.x.x

User: abb

Password: abb

ftp> cd log
ftp> get error.log
ftp> quit
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10. Troubleshooting

Communication to SPA-ZC 40x is not working

If communication problems occur, check the firewall configurations. Table 10.-1
shows the ports that have to be open in firewall.

Table 10.-1 TCP/IP and UDP ports

TCP UDP

SPA Over TCP and CET tool
IP Query port

7001 7001

FTP file transfer protocol ports 21, 20

IEC 61850 communication
protocol port

102

Network time management
protocol port

123

Modbus TCP port 502

A firewall may prevent the FTP and IP Query to work. In case of problems, adjust
the firewall settings so that the ports listed in Table 10.-1 are open. IP Query uses the
broadcast address 255.255.255.255 to which the query is sent and which may also
be blocked.

Windows XP SP 2 contains a built-in firewall.
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11. Technical reference
This chapter defines the compliance to IEC 61850 in terms of service, modeling,
engineering interfaces and also exceptions and local adaptations. The information
gives you a detailed explanation of the IEC 61850 capabilities of a product.

This chapter provides information about the following issues:

* ACSI conformance statement
* Model conformance statement
* SCL conformance statement
* SCL control block
* Protocol implementation conformance statement

The ACSI conformance statement describes the abstract service interfaces, which
are normally mapped to specific communication service (SCSM) and therefore
indirectly stated in the protocol implementation conformance statement. The
conformance statements and documents are referred to as Protocol Implementation
Conformance Statement (PICS) and Model Implementation Conformance Statement
(MICS).

For the following clauses, the following definitions apply:

Table 11.-1 Notations

M/m Mandatory support. The item must be implemented.

C/c Conditional support. The item must be implemented if the stated
condition exists.

O/o Optional support. The implementation may decide to implement
the item.

x The implementation must not implement this item (excluded).

i The implementation of the item is not within the scope of this
product (out-of-scope).

F/S Functional Standard. Should be applied.

Base Must be applied in any application claiming conformance to this
standard.

SPA/ Ethernet Adapter

SPA to IEC 61850 Gateway
Installation and Commissioning Manual

SPA-ZC 402SPA-ZC 4021MRS755380



11.1. ACSI conformance statement

Table 11.1.-1 ACSI basic conformance statement

Client/ Subscriber Server/ Publisher
SPA-ZC 402/
Comments

Client-Server roles

B11 Server side (of TWO-
PARTY-APPLICATION-
ASSOCIATION)

– a Supported

B12 Client side (of TWO-
PARTY-APPLICATION-
ASSOCIATION)

a –

SCSMs supported

B21 SCSM: IEC 61850-8-1
used

Supported

B22 SCSM: IEC 61850-9-1
used

Not Supported

B23 SCSM: IEC 61850-9-2
used

Not Supported

B24 SCSM: other

Generic substation event model (GSE)

B31 Publisher side – O Supported

B32 Subscriber side O – Supported

Transmission of sampled value model (SVC)

B41 Publisher side – O Not Supported

B42 Subscriber side O – Not Supported

11.2. Model conformance statement

In this chapter the Model Implementation Conformance Statement (MICS) is
defined detailing the standard data object model elements supported by SPA-ZC 402
. It is also possible to export the information in MICS to a CID file. The CID file can
be used in the system tool, see Safety information. Some of the data cannot be
retrieved from the IED, but it is the default value in the SPA-ZC 402.

11.2.1. Common data attribute classes
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11.2.1.1. Quality

Table 11.2.1.1.-1 Quality

Quality Type Definition

Attribute Name AttributeType
Value/ Value
Range

M/O/C
SPA-ZC 402/
Comments

PACKED LIST

validity CODED ENUM good | invalid |
reserved |
questionable

M Supported

detailQual PACKED LIST M Supported

overflow BOOLEAN M Defaulted

outOfRange BOOLEAN M Supported

badRefererence BOOLEAN M Defaulted

oscillatory BOOLEAN M Defaulted

failure BOOLEAN M Defaulted

oldData BOOLEAN M Supported

inconsistent BOOLEAN M Defaulted

inaccurate BOOLEAN M Defaulted

source CODED ENUM process |
substituted
DEFAULT
process

M Supported

test BOOLEAN DEFAULT
FALSE

M Defaulted

operatorBlocked BOOLEAN DEFAULT
FALSE

M Defaulted

The DEFAULT value must be applied, if the functionality of the related
attribute is Not Supported. The mapping may specify to exclude the
attribute from the message, if it is Not Supported or if the DEFAULT
value applies.
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11.2.1.2. Analogue value

Table 11.2.1.2.-1 Analogue value

AnalogueValue Type Definition

Attribute Name AttributeType Value/ Value Range M/O/C
SPA-ZC 402/
Comments

I INT32 integer value GC_1 Not Supported

f FLOAT 32 floating point value GC_1 Supported

11.2.1.3. Configuration of analogue value

Table 11.2.1.3.-1 Configuration of analogue value

ScaledValueConfig Type Definition

Attribute Name AttributeType Value/ Value Range M/O/C
SPA-ZC 402/
Comments

scaleFactor FLOAT 32 M Not Supported

offset FLOAT 32 M Not Supported

11.2.1.4. Range configuration

Table 11.2.1.4.-1 Range configuration

RangeConfig Type Definition

Attribute Name AttributeType Value/ Value Range M/O/C SPA-ZC 402/Comments

hhLim AnalogueValue M Supported

hLim AnalogueValue M Supported

ILim AnalogueValue M Supported

IILim AnalogueValue M Supported

min AnalogueValue M Supported

max AnalogueValue M Supported

11.2.1.5. Step position with transient indication

Table 11.2.1.5.-1 Step position with transient indication

ValWithTrans Type Definition

Attribute Name AttributeType Value/ Value Range M/O/C SPA-ZC 402/Comments

posVal INT8 -64 ... 63 M Supported

transInd BOOLEAN O Not Supported
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11.2.1.6. Originator

Table 11.2.1.6.-1 Step position with transient indication

OriginatorType Definition

Attribute Name AttributeType Value/ Value Range M/O/C
SPA-ZC 402/
Comments

orCat ENUMERATED not-supported | bay-
control | station-control |
remote-control |
automatic-bay |
automatic-station |
automatic-remote |
maintenance | process

M Supported

orIdent OCTET STRING64 M Supported

Table 11.2.1.6.-2 Values for orCat

Value Explanation

bay-control Control operation issued from an operator using a client
located at bay level

station-control Control operation issued from an operator using a client
located at station level

remote-control Control operation from a remote operater outside the
substation (e.g. network control center)

automatic-bay Control operation issued from an automatic function at bay
level

automatic-station Control operation issued from an automatic function at station
level

automatic-remote Control operation issued from an automatic function outside of
the substation

maintenance Control operation issued from a maintenance / service tool

process Status change occurred without control action (e.g. external
trip of a circuit breaker or failure inside the breaker)

11.2.1.7. Unit definition

Table 11.2.1.7.-1 Unit

Unit Type Definition

Attribute Name AttributeType Value/ Value Range M/O/C
SPA-ZC 402/
Comments

SIUnit ENUMERATED According to table in
Annex A

M Supported

multiplier ENUMERATED According to table in
Annex A

O Supported
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11.2.1.8. Vector definition

Table 11.2.1.8.-1 Vector

Vector Type Definition

Attribute Name AttributeType Value/ Value Range M/O/C
SPA-ZC 402/
Comments

mag AnalogueValue M Supported

ang AnalogueValue O Not Supported

11.2.1.9. CTxInt

Context specific Integer. The type depends on the DO usage. Enum type is used
with the Mod, Beh and Health Data Objects, otherwise Int32 is used.

11.2.2. Common data classes

11.2.2.1. Single point status (SPS)

Table 11.2.2.1.-1 defines the common data class of single point status.

Table 11.2.2.1.-1 Single point status (SPS)

SPS class

Attribute Name Attribute Type FC TrgOp
Value/ Value
range

M/O/C
SPA-ZC 402/
Comments

DataName Inherited from Data Class (refer to IEC 61850-7-2) Supported

DataAttribute

Status

stVal BOOLEAN ST dchg TRUE | FALSE M Supported

q Quality ST qchg M Supported

t TimeStamp ST M Supported

Substitution

subEna BOOLEAN SV PICS_SUBST Not Supported

subVal BOOLEAN SV TRUE | FALSE PICS_SUBST Not Supported

subQ Quality SV PICS_SUBST Not Supported

subID VISIBLE
STRING64

SV PICS_SUBST Not Supported

Configuration, description and extension

d VISIBLE
STRING255

DC Text O Supported

cdcNs VISIBLE
STRING255

EX AC_DLNDA_M Not Supported

cdcName VISIBLE
STRING255

EX AC_DLNDA_M Not Supported

dataNs VISIBLE
STRING255

EX AC_DLNDA_M Not Supported

74

SPA-ZC 402SPA-ZC 402 SPA/ Ethernet Adapter
SPA to IEC 61850 Gateway

Installation and Commissioning Manual

1MRS755380



75

11.2.2.2. Double point status (DPS)

The table 11.2.2.2.-1 defines the common data class of double point status.

Table 11.2.2.2.-1 Double point status (DPS)

DBS class

Attribute Name Attribute Type FC TrgOp
Value/ Value
range

M/O/C
SPA-ZC 402/
Comments

DataName Inherited from Data Class (refer to IEC 61850-7-2) Supported

DataAttribute

Status

stVal CODED ENUM ST dchg intermediate-
state | off | on |
bad-state

M Supported

q Quality ST qchg M Supported

t TimeStamp ST M Supported

Substitution

subEna BOOLEAN SV PICS_SUBST Not Supported

subVal INT32 SV PICS_SUBST Not Supported

subQ Quality SV PICS_SUBST Not Supported

subID VISIBLE
STRING64

SV PICS_SUBST Not Supported

Configuration, Description and extension

d VISIBLE
STRING255

DC Text O Supported

cdcNs VISIBLE
STRING255

EX AC_DLNDA_M Not Supported

cdcName VISIBLE
STRING255

EX AC_DLNDA_M Not Supported

dataNs VISIBLE
STRING255

EX AC_DLNDA_M Not Supported

11.2.2.3. Integer status (INS)

Table 11.2.2.3.-1 defines the common data class of integer status.

Table 11.2.2.3.-1 Integer status (INS)

INS class

Attribute Name Attribute Type FC TrgOp
Value/ Value
range

M/O/C
SPA-ZC 402/
Comments

DataName Inherited from Data Class (refer to IEC 61850-7-2) Supported

DataAttribute

Status

stVal CtxInt ST dchg M Supported

q Quality ST qchg M Supported

t TimeStamp ST M Supported
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INS class

Attribute Name Attribute Type FC TrgOp
Value/ Value
range

M/O/C
SPA-ZC 402/
Comments

Substitution

subEna BOOLEAN SV PICS_SUBST Not Supported

subVal CtxInt SV PICS_SUBST Not Supported

subQ Quality SV PICS_SUBST Not Supported

subID VISIBLE
STRING64

SV PICS_SUBST Not Supported

Configuration, Description and Extension

d VISIBLE
STRING255

DC Text O Supported

cdcNs VISIBLE
STRING255

EX AC_DLNDA_M Not Supported

cdcName VISIBLE
STRING255

EX AC_DLNDA_M Not Supported

dataNs VISIBLE
STRING255

EX AC_DLN_M Not Supported

11.2.2.4. Protection activation information (ACT)

Table 11.2.2.4.-1 defines the common data class of protection activation
information.

Table 11.2.2.4.-1 Protection activation information (ACT)

ACT class

Attribute Name Attribute Type FC TrgOp
Value/ Value
range

M/O/C
SPA-ZC 402/
Comments

DataName Inherited from Data Class (refer to IEC 61850-7-2) Supported

DataAttribute

Status

general BOOLEAN ST dchg M Supported

phsA BOOLEAN ST dchg O Supported

phsB BOOLEAN ST dchg O Supported

phsC BOOLEAN ST dchg O Supported

neut BOOLEAN ST dchg O Supported

q Quality ST qchg M Supported

t TimeStamp ST M Supported

Configuration, Description and Extension

operTm TimeStamp CF O Not Supported

d VISIBLE
STRING255

DC Text O Supported

cdcNs VISIBLE
STRING255

EX AC_DLNDA_M Not Supported

cdcName VISIBLE
STRING255

EX AC_DLNDA_M Not Supported

dataNs VISIBLE
STRING255

EX AC_DLN_M Not Supported

76

SPA-ZC 402SPA-ZC 402 SPA/ Ethernet Adapter
SPA to IEC 61850 Gateway

Installation and Commissioning Manual

1MRS755380



77

ACT class

Attribute Name Attribute Type FC TrgOp
Value/ Value
range

M/O/C
SPA-ZC 402/
Comments

Different variants of the type exist based on the connectivity package
short address information (sAddr). Underlined information indicates
the basic type.

11.2.2.5. Directional protection activation information (ACD)

Table 11.2.2.5.-1 defines the common data class of directional protection activation
information.

Table 11.2.2.5.-1 Directional protection activation information (ACD)

ACD class

Attribute Name Attribute Type FC TrgOp
Value/ Value
range

M/O/C
SPA-ZC 402/
Comments

DataName Inherited from Data Class (refer to IEC 61850-7-2) Supported

DataAttribute

Status

general BOOLEAN ST dchg M Supported

dirGeneral ENUMERATED ST dchg unknown |
forward |
backward | both

M Supported

PhsA BOOLEAN ST dchg GC_2 (1) Supported

dirPhsA ENUMERATED ST dchg unknown |
forward |
backward

GC_2 (1) Supported

PhsB BOOLEAN ST dchg GC_2 (2) Supported

dirPhsB ENUMERATED ST dchg unknown |
forward |
backward

GC_2 (2) Supported

PhsC BOOLEAN ST dchg GC_2 (3) Supported

dirPhsC ENUMERATED ST dchg unknown |
forward |
backward

GC_2 (3) Supported

Neut BOOLEAN ST dchg GC_2 (4) Supported

dirNeut ENUMERATED ST dchg unknown |
forward |
backward

GC_2 (4) Supported

q Quality ST qchg M Supported

t TimeStamp ST M Supported

Configuration, Description and Extension

d VISIBLE
STRING255

DC Text O Supported
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ACD class

Attribute Name Attribute Type FC TrgOp
Value/ Value
range

M/O/C
SPA-ZC 402/
Comments

cdcNs VISIBLE
STRING255

EX AC_DLNDA_M Not Supported

cdcName VISIBLE
STRING255

EX AC_DLNDA_M Not Supported

dataNs VISIBLE
STRING255

EX AC_DLN_M Not Supported

Different variants of the type exist based on the connectivity package
short address information (sAddr). Underlined information indicates
the basic type.

11.2.2.6. Security violation counting (SEC)

Table 11.2.2.6.-1 defines the common data class of security violation counting.

Table 11.2.2.6.-1 Security violation counting (SEC)

SEC class

Attribute Name Attribute Type FC TrgOp
Value/ Value
range

M/O/C
SPA-ZC 402/
Comments

DataName Inherited from Data Class (refer to IEC 61850-7-2) Not Supported

DataAttribute

Status

cnt INT32U ST dchg M Not Supported

sev ENUMERATED ST unknown | critical
| major | minor |
warning

M Not Supported

T TimeStamp ST M Not Supported

addr OCTET
STRING64

ST O Not Supported

addInfo VISIBLE
STRING64

ST O Not Supported

Configuration, Description and Extension

D VISIBLE
STRING255

DC O Not Supported

cdcNs VISIBLE
STRING255

EX AC_DLNDA_M Not Supported

cdcName VISIBLE
STRING255

EX AC_DLNDA_M Not Supported

dataNs VISIBLE
STRING255

EX AC_DLN_M Not Supported
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11.2.2.7. Binary counter reading (BCR)

Table 11.2.2.7.-1 defines the common data class of binary counter reading.

Table 11.2.2.7.-1 Binary counter reading (BCR)

BCR class

Attribute Name Attribute Type FC TrgOp
Value/ Value
range

M/O/C
SPA-ZC 402/
Comments

DataName Inherited from Data Class (refer to IEC 61850-7-2) Supported

DataAttribute

Status

actVal INT128 ST dchg M Supported

frVal INT128 ST dupd GC_2 (1) Not Supported

frTm TimeStamp ST dupd GC_2 (1) Not Supported

q Quality ST qchg M Supported

t TimeStamp ST M Supported

Configuration, Description and Extension

units Unit CF see Annex A O Not Supported

pulsQty FLOAT32 CF M Supported

frEna BOOLEAN CF GC_2 (1) Not Supported

strTm TimeStamp CF GC_2 (1) Not Supported

frPd INT32 CF GC_2 (1) Not Supported

frRds BOOLEAN CF GC_2 (1) Not Supported

d VISIBLE
STRING255

DC O Supported

cdcNs VISIBLE
STRING255

EX AC_DLNDA_M Not Supported

cdcName VISIBLE
STRING255

EX AC_DLNDA_M Not Supported

dataNs VISIBLE
STRING255

EX AC_DLN_M Not Supported

11.2.2.8. Measured value (MV)

Table 11.2.2.8.-1 defines the common data class of measured value.

Table 11.2.2.8.-1 Measured value (MV)

MV class

Attribute Name Attribute Type FC TrgOp
Value/ Value
range

M/O/C
SPA-ZC 402/
Comments

DataName Inherited from Data Class (refer to IEC 61850-7-2) Supported

DataAttribute

Measured Values

instMag AnalogueValue MX O Not Supported

mag AnalogueValue MX dchg M Supported
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MV class

Attribute Name Attribute Type FC TrgOp
Value/ Value
range

M/O/C
SPA-ZC 402/
Comments

range ENUMERATED MX dchg normal | high |
low | high-high |
low-low | …

O Supported

q Quality MX qchg M Supported

t TimeStamp MX M Supported

Substitution

subEna BOOLEAN SV PICS_SUBST Not Supported

subVal AnalogueValue SV PICS_SUBST Not Supported

subQ Quality SV PICS_SUBST Not Supported

subID VISIBLE
STRING64

SV PICS_SUBST Not Supported

Configuration, Description and Extension

units Unit CF see Annex A O Supported

db INT32U CF 0...100 000 O Not Supported

zeroDb INT32U CF 0...100 000 O Not Supported

sVC ScaledValue-
Config

CF AC_SCAV Not Supported

rangeC RangeConfig CF GC_CON Not Supported

smpRate INT32U CF O Not Supported

d VISIBLE
STRING255

DC Text O Supported

cdcNs VISIBLE
STRING255

EX AC_DLNDA_M Not Supported

cdcName VISIBLE
STRING255

EX AC_DLNDA_M Not Supported

dataNs VISIBLE
STRING255

EX AC_DLN_M Not Supported

Different variants of the type exist based on the connectivity package
short address information (sAddr). Underlined information indicates
the basic type.

11.2.2.9. Complex measured value (CMV)

Table 11.2.2.9.-1 defines the common data class of measured value.
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Table 11.2.2.9.-1 Complex measured value (CMV)

CMV class

Attribute Name Attribute Type FC TrgOp
Value/ Value
range

M/O/C
SPA-ZC 402/
Comments

DataName Inherited from Data Class (refer to IEC 61850-7-2) Supported

DataAttribute

Measured Values

instCVal Vector MX O Not Supported

cVal Vector MX dchg M Supported

range ENUMERATED MX dchg normal | high |
low | high-high |
low-low | …

O Supported

q Quality MX qchg M Supported

t TimeStamp MX M Supported

Substitution

subEna BOOLEAN SV PICS_SUBST Not Supported

subCVal Vector SV PICS_SUBST Not Supported

subQ Quality SV PICS_SUBST Not Supported

subID VISIBLE
STRING64

SV PICS_SUBST Not Supported

Configuration, Description and Extension

units Unit CF see Annex A O Supported

db INT32U CF 0...100 000 O Not Supported

zeroDb INT32U CF 0...100 000 O Not Supported

rangeC RangeConfig CF GC_CON Supported

magSVC ScaledValue-
Config

AC_SCAV Not Supported

angSVC ScaledValue-
Config

AC_SCAV Not Supported

angRef ENUMERATED CF V | A | other ... O Not Supported

smpRate INT32U CF O Not Supported

d VISIBLE
STRING255

DC Text O Supported

cdcNs VISIBLE
STRING255

EX AC_DLNDA_M Not Supported

cdcName VISIBLE
STRING255

EX AC_DLNDA_M Not Supported

dataNs VISIBLE
STRING255

EX AC_DLN_M Not Supported

Different variants of the type exist based on the connectivity package
short address information (sAddr). Underlined information indicates
the basic type.
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11.2.2.10. WYE

Table 11.2.2.10.-1 defines the common data class of WYE.

Table 11.2.2.10.-1 WYE

SAV class

Attribute Name Attribute Type FC TrgOp
Value/ Value
range

M/O/C
SPA-ZC 402/
Comments

DataName Inherited from Data Class (refer to IEC 61850-7-2) Supported

Data

phsA CMV GC_1 Supported

phsB CMV GC_1 Supported

phsC CMV GC_1 Supported

neut CMV GC_1 Supported

net CMV GC_1 Not Supported

res CMV GC_1 Not Supported

DataAttribute

Configuration, Description and Extension

angRef ENUMERATED CF Va | Vb | Vc | Aa |
Ab | Ac | Vab |
Vbc | Vca |
Vother | Aother

O Not Supported

d VISIBLE
STRING255

DC Text O Supported

cdcNs VISIBLE
STRING255

EX AC_DLNDA_M Not Supported

cdcName VISIBLE
STRING255

EX AC_DLNDA_M Not Supported

dataNs VISIBLE
STRING255

EX AC_DLN_M Not Supported

Different variants of the type exist based on the CMV type variant.

11.2.2.11. Delta (DEL)

Table 11.2.2.11.-1 defines the common data class of delta.
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Table 11.2.2.11.-1 Delta (DEL)

SAV class

Attribute Name Attribute Type FC TrgOp
Value/ Value
range

M/O/C
SPA-ZC 402/
Comments

DataName Inherited from Data Class (refer to IEC 61850-7-2) Supported

Data

phsAB CMV GC_1 Supported

phsBC CMV GC_1 Supported

phsCA CMV GC_1 Supported

DataAttribute

Configuration, Description and Extension

angRef ENUMERATED CF Va | Vb | Vc | Aa |
Ab | Ac | Vab |
Vbc | Vca |
Vother | Aother

O Not Supported

d VISIBLE
STRING255

DC Text O Supported

cdcNs VISIBLE
STRING255

EX AC_DLNDA_M Not Supported

cdcName VISIBLE
STRING255

EX AC_DLNDA_M Not Supported

dataNs VISIBLE
STRING255

EX AC_DLN_M Not Supported

Different variants of the type exist based on the CMV type variant.

11.2.2.12. Sequence (SEQ)

Table 11.2.2.12.-1 defines the common data class of sequence.

Table 11.2.2.12.-1 Sequence (SEQ)

SAV class

Attribute Name Attribute Type FC TrgOp
Value/ Value
range

M/O/C
SPA-ZC 402/
Comments

DataName Inherited from Data Class (refer to IEC 61850-7-2) Not Supported

Data

c1 CMV M Supported

c2 CMV M Supported

c3 CMV M Supported

DataAttribute

Measured values

seqT ENUMERATED CF pos-neg-zero |
dir-quad-zero

M Supported

M Configuration, Description and Extension
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SAV class

Attribute Name Attribute Type FC TrgOp
Value/ Value
range

M/O/C
SPA-ZC 402/
Comments

phsRef ENUMERATED CF A | B | C | … O Not Supported

d VISIBLE
STRING255

DC Text O Supported

cdcNs VISIBLE
STRING255

EX AC_DLNDA_M Not Supported

cdcName VISIBLE
STRING255

EX AC_DLNDA_M Not Supported

dataNs VISIBLE
STRING255

EX AC_DLN_M Not Supported

11.2.2.13. Harmonic Value (HMV)

Table 11.2.2.13.-1 defines the common data class of harmonic value.

Table 11.2.2.13.-1 Harmonic Value (HMV)

HMV class

Attribute Name Attribute Type FC TrgOp
Value/ Value
range

M/O/C
SPA-ZC 402/
Comments

DataName Inherited from Data Class (refer to IEC 61850-7-2) Not Supported

DataAttribute

Measured Values

Basics

q Quality MX qchg M Not Supported

t TimeStamp MX M Not Supported

Harmonics and Interharmonics

har ARRAY[0..
numHar] OF
Vector

MMX dchg, dupd M Not Supported

Configuration, Description and Extension

numHar INT16U CF >1 M Not Supported

numCycl INT16U CF >0 M Not Supported

evalTim INT16U CF M Not Supported

units Unit CF see Annex A O Not Supported

smpRate INT32U CF O Not Supported

frequency FLOAT32U CF fundamental
frequency

M Not Supported

hvRef ENUMERATED CF fundamental |
rms | absolute

O Not Supported

rmsTim INT32U CF AC_RMS_M Not Supported

d VISIBLE
STRING255

DC Text O Not Supported
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HMV class

Attribute Name Attribute Type FC TrgOp
Value/ Value
range

M/O/C
SPA-ZC 402/
Comments

cdcNs VISIBLE
STRING255

EX AC_DLNDA_M Not Supported

cdcName VISIBLE
STRING255

EX AC_DLNDA_M Not Supported

dataNs VISIBLE
STRING255

EX AC_DLN_M Not Supported

Harmonics for a single circuit have phase angles (optional) but need no
reference for the angle (angRef) since by convention the reference is
always the fundamental frequency (index 1).

11.2.2.14. Harmonic value for WYE (HWYE)

Table 11.2.2.14.-1 defines the common data class of harmonic value for WYE.

Table 11.2.2.14.-1 Harmonic value for WYE (HWYE)

HWYE class

Attribute Name Attribute Type FC TrgOp
Value/ Value
range

M/O/C
SPA-ZC 402/
Comments

DataName Inherited from Data Class (refer to IEC 61850-7-2) Not Supported

DataAttribute

Measured Values

Basics

q Quality MX qchg M Not Supported

t TimeStamp MX M Not Supported

Harmonics and Interharmonics

phsAHar ARRAY[0..
numHar] OF
Vector

MX dchg, dupd M Not Supported

phsBHar ARRAY[0..
numHar] OF
Vector

MX dchg, dupd O Not Supported

phsCHar ARRAY[0..
numHar] OF
Vector

MX dchg, dupd O Not Supported

neutHar ARRAY[0..
numHar] OF
Vector

MX dchg, dupd O Not Supported

netHar ARRAY[0..
numHar] OF
Vector

MX dchg, dupd O Not Supported
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HWYE class

Attribute Name Attribute Type FC TrgOp
Value/ Value
range

M/O/C
SPA-ZC 402/
Comments

resHar ARRAY[0..
numHar] OF
Vector

MX dchg, dupd O Not Supported

Configuration, Description and Extension

numHar INT16U CF >1 M Not Supported

numCycl INT16U CF >0 M Not Supported

evalTim INT16U CF M Not Supported

units Unit CF see Annex A O Not Supported

angRef ENUMERATED CF Va | Vb | Vc | Aa |
Ab | Ac | Vab |
Vbc | Vca |
Vother | Aother |

O Not Supported

smpRate INT32U CF O Not Supported

frequency FLOAT32U CF fundamental
frequency

M Not Supported

hvRef ENUMERATED CF fundamental |
rms | absolute

O Not Supported

rmsTim INT32U CF AC_RMS_M Not Supported

d VISIBLE
STRING255

DC Text O Not Supported

cdcNs VISIBLE
STRING255

EX AC_DLNDA_M Not Supported

cdcName VISIBLE
STRING255

EX AC_DLNDA_M Not Supported

dataNs VISIBLE
STRING255

EX AC_DLN_M Not Supported

11.2.2.15. Harmonic value for DEL (HDEL)

Table 11.2.2.15.-1 below defines the common data class of harmonic value for
DEL.

Table 11.2.2.15.-1 Harmonic value for DEL (HDEL)

HDEL class

Attribute Name Attribute Type FC TrgOp
Value/ Value
range

M/O/C
SPA-ZC 402/
Comments

DataName Inherited from Data Class (refer to IEC 61850-7-2) Not Supported

DataAttribute

Measured Values

Basics

q Quality MX qchg M Not Supported

t TimeStamp MX M Not Supported

Harmonics and Interharmonics

phsABHar ARRAY[0..
numHar] OF
Vector

MX dchg, dupd M Not Supported
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HDEL class

Attribute Name Attribute Type FC TrgOp
Value/ Value
range

M/O/C
SPA-ZC 402/
Comments

phsBCHar ARRAY[0..
numHar] OF
Vector

MX dchg, dupd O Not Supported

phsCAHar ARRAY[0..
numHar] OF
Vector

MX dchg, dupd O Not Supported

Configuration, Description and Extension

numHar INT16U CF >1 M Not Supported

numCycl INT16U CF >0 M Not Supported

evalTim INT16U CF M Not Supported

units Unit CF see Annex A O Not Supported

angRef ENUMERATED CF Va | Vb | Vc | Aa |
Ab | Ac | Vab |
Vbc | Vca |
Vother | Aother |

O Not Supported

smpRate INT32U CF O Not Supported

frequency FLOAT32U CF fundamental
frequency

M Not Supported

hvRef ENUMERATED CF fundamental |
rms | absolute

O Not Supported

rmsTim INT32U CF AC_RMS_M Not Supported

d VISIBLE
STRING255

DC Text O Not Supported

cdcNs VISIBLE
STRING255

EX AC_DLNDA_M Not Supported

cdcName VISIBLE
STRING255

EX AC_DLNDA_M Not Supported

dataNs VISIBLE
STRING255

EX AC_DLN_M Not Supported

11.2.2.16. Controllable single point (SPC)

Table 11.2.2.16.-1 defines the common data class of controllable single point.

Table 11.2.2.16.-1 Controllable single point (SPC)

SPC class

Attribute Name Attribute Type FC TrgOp
Value/ Value
range

M/O/C
SPA-ZC 402/
Comments

DataName Inherited from Data Class (refer to IEC 61850-7-2) Supported

DataAttribute

Control and Status

ctlVal BOOLEAN CO off (FALSE) | on
(TRUE)

AC_CO_M Supported

operTm TimeStamp CO AC_CO_O Not Supported

origin Originator ST AC_CO_O Not Supported

ctlNum INT8U ST 0..255 AC_CO_O Not Supported
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SPC class

Attribute Name Attribute Type FC TrgOp
Value/ Value
range

M/O/C
SPA-ZC 402/
Comments

stVal BOOLEAN ST dchg FALSE | TRUE AC_ST Supported

q Quality ST qchg AC_ST Supported

t TimeStamp ST AC_ST Supported

stSeld BOOLEAN ST dchg AC_CO_O Not Supported

Substitution

subEna BOOLEAN SV PICS_SUBST Not Supported

subVal BOOLEAN SV FALSE | TRUE PICS_SUBST Not Supported

subQ Quality SV PICS_SUBST Not Supported

subID VISIBLE
STRIN64

SV PICS_SUBST Not Supported

Configuration, Description and Extension

pulseConfig PulseConfig CF AC_CO_O Not Supported

ctlModel ENUMERATED CF Status-only |
direct-with-
normal-security |
sbo-with-normal-
security | direct-
with-enhanced-
security | sbo-
with-enhanced-
security

M Supported

sboTimeout INT32U CF AC_CO_O Not Supported

sboClass ENUMERATED CF operate-once |
operate-many

AC_CO_O Not Supported

d VISIBLE
STRING255

DC Text O Supported

cdcNs VISIBLE
STRING255

EX AC_DLNDA_M Not Supported

cdcName VISIBLE
STRING255

EX AC_DLNDA_M Not Supported

dataNs VISIBLE
STRING255

EX AC_DLN_M Not Supported

Different variants of the type exist based on the connectivity package
short address information (sAddr). Underlined information indicates
the basic type.

11.2.2.17. Controllable double point (DPC)

Table 11.2.2.17.-1 defines the common data class of controllable double point.
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Table 11.2.2.17.-1 Controllable double point (DPC)

SPC class

Attribute Name Attribute Type FC TrgOp
Value/ Value
range

M/O/C
SPA-ZC 402/
Comments

DataName Inherited from Data Class (see IEC 61850-7-2) Supported

DataAttribute

Control and Status

ctlVal BOOLEAN CO off (FALSE) | on
(TRUE)

AC_CO_M Supported

operTm TimeStamp CO AC_CO_O Not Supported

origin Originator ST AC_CO_O Supported

ctlNum INT8U ST 0..255 AC_CO_O Supported

stVal CODED ENUM ST dchg intermediate-
state | off | on |
bad-state

M Supported

q Quality ST qchg M Supported

t TimeStamp ST M Supported

stSeld BOOLEAN ST dchg AC_CO_O Supported

Substitution

subEna BOOLEAN SV PICS_SUBST Not Supported

subVal CODED ENUM SV intermediate-
state | off | on |
bad-state

PICS_SUBST Not Supported

subQ Quality SV PICS_SUBST Not Supported

subID VISIBLE
STRING64

SV PICS_SUBST Not Supported

Configuration, Description and Extension

pulseConfig PulseConfig CF AC_CO_O Not Supported

ctlModel ENUMERATED CF status-only |
direct-with-
normal-security |
sbo-with-normal-
security | direct-
with-enhanced-
security | sbo-
with-enhanced-
security

M Supported

sboTimeout INT32U CF AC_CO_O Not Supported

sboClass ENUMERATED CF operate-once (0)
| operate-many
(1)

AC_CO_O Not Supported

d VISIBLE
STRING255

DC Text O Supported

cdcNs VISIBLE
STRING255

EX AC_DLNDA_M Not Supported

cdcName VISIBLE
STRING255

EX AC_DLNDA_M Not Supported

dataNs VISIBLE
STRING255

EX AC_DLN_M Not Supported
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Different variants of the type exist based on the connectivity package
short address information (sAddr). Underlined information indicates
the basic type.

11.2.2.18. Controllable integer status (INC)

Table 11.2.2.18.-1 defines the common data class of controllable integer status.

Table 11.2.2.18.-1 Controllable integer status (INC)

INC class

Attribute Name Attribute Type FC TrgOp
Value/ Value
range

M/O/C
SPA-ZC 402/
Comments

DataName Inherited from Data Class (refer to IEC 61850-7-2) Supported

DataAttribute

Control and Status

ctlVal CtxInt CO AC_CO_M Supported

operTm TimeStamp CO AC_CO_O Not Supported

origin Originator ST AC_CO_O Not Supported

ctlNum INT8U ST 0..255 AC_CO_O Not Supported

stVal INT32 ST dchg M Supported

q Quality ST qchg M Supported

t TimeStamp ST M Supported

stSeld BOOLEAN ST dchg AC_CO_O Not Supported

Substitution

subEna BOOLEAN SV PICS_SUBST Not Supported

subVal ValWithTrans SV PICS_SUBST Not Supported

subQ Quality SV PICS_SUBST Not Supported

subID VISIBLE
STRING64

SV PICS_SUBST Not Supported

Configuration, Description and Extension

persistent BOOLEAN CF M Not Supported

ctlModel ENUMERATED CF Status-only |
direct-with-
normal-security |
sbo-with-normal-
security | direct-
with-enhanced-
security | sbo-
with-enhanced-
security

M Supported

sboTimeout INT32U CF AC_CO_O Not Supported

sboClass ENUMERATED CF operate-once |
operate-many

AC_CO_O Not Supported

minVal INT8 CF O Not Supported
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INC class

Attribute Name Attribute Type FC TrgOp
Value/ Value
range

M/O/C
SPA-ZC 402/
Comments

maxVal INT8 CF O Not Supported

stepSize INT8U CF 1 ... (maxVal -
minVal)

O Not Supported

d VISIBLE
STRING255

DC Text O Supported

cdcNs VISIBLE
STRING255

EX AC_DLNDA_M Supporteda)

cdcName VISIBLE
STRING255

EX AC_DLNDA_M Not Supported

dataNs VISIBLE
STRING255

EX AC_DLN_M Not Supported

a) cdcNs is only used for the LD0.Mod diagnostics. It is not possible to change it.

Different variants of the type exist based on the connectivity package
short address information (sAddr). Underlined information indicates
the basic type.

11.2.2.19. Binary controlled step position information (BSC)

Table 11.2.2.19.-1 defines the common data class of binary controlled step position
information.

Table 11.2.2.19.-1 Binary controlled step position information (BSC)

BSC class

Attribute Name Attribute Type FC TrgOp
Value/ Value
range

M/O/C
SPA-ZC 402/
Comments

DataName Inherited from Data Class (refer to IEC 61850-7-2) Supported

DataAttribute

Control and Status

ctlVal ENUMERATED CO stop | lower |
higher | reserved

AC_CO_M Supported

operTm TimeStamp CO AC_CO_O Not Supported

origin Originator ST AC_CO_O Not Supported

ctlNum INT8U ST 0..255 AC_CO_O Not Supported

valWTr ValWithTrans ST dchg AC_ST Supported

q Quality ST qchg AC_ST Supported

t TimeStamp ST AC_ST Supported

stSeld BOOLEAN ST dchg FALSE | TRUE AC_CO_O Not Supported

Substitution

subEna BOOLEAN SV PICS_SUBST Not Supported

subVal ValWithTrans SV PICS_SUBST Not Supported

subQ Quality SV PICS_SUBST Not Supported
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BSC class

Attribute Name Attribute Type FC TrgOp
Value/ Value
range

M/O/C
SPA-ZC 402/
Comments

subID VISIBLE
STRING64

SV PICS_SUBST Not Supported

Configuration, Description and Extension

persistent BOOLEAN CF M Supported

ctlModel ENUMERATED CF Status-only |
direct-with-
normal-security |
sbo-with-normal-
security | direct-
with-enhanced-
security | sbo-
with-enhanced-
security

M Supported

sboTimeout INT32U CF AC_CO_O Not Supported

sboClass ENUMERATED CF operate-once |
operate-many

AC_CO_O Not Supported

minVal INT8 CF O Not Supported

maxVal INT8 CF O Not Supported

stepSize INT8U CF 1 ... (maxVal -
minVal)

O Not Supported

d VISIBLE
STRING255

DC Text O Supported

cdcNs VISIBLE
STRING255

EX AC_DLNDA_M Not Supported

cdcName VISIBLE
STRING255

EX AC_DLNDA_M Not Supported

dataNs VISIBLE
STRING255

EX AC_DLN_M Not Supported

Different variants of the type exist based on the control model
(ctlModel) and connectivity packet short address information.
Underlined information indicates the basic type.

11.2.2.20. Integer controlled step position information (ISC)

Table 11.2.2.20.-1 defines the common data class of integer controlled step position
information.
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Table 11.2.2.20.-1 Integer controlled step position information (ISC)

ISC class

Attribute Name Attribute Type FC TrgOp
Value/ Value
range

M/O/C
SPA-ZC 402/
Comments

DataName Inherited from Data Class (see IEC 61850-7-2) Not Supported

DataAttribute

Control and Status

ctlVal INT8 CO -64 … 63 AC_CO_M Not Supported

operTm TimeStamp CO AC_CO_O Not Supported

origin Originator CO ST AC_CO_O Not Supported

ctlNum INT8U CO ST 0..255 AC_CO_O Not Supported

valWTr ValWithTrans ST dchg AC_ST Supported

q Quality ST qchg AC_ST Supported

t TimeStamp ST AC_ST Not Supported

stSeld BOOLEAN ST dchg AC_CO_O Not Supported

Substitution

subEna BOOLEAN SV PICS_SUBST Not Supported

subVal ValWithTrans SV PICS_SUBST Not Supported

subQ Quality SV PICS_SUBST Not Supported

subID VISIBLE
STRING 64

SV PICS_SUBST Not Supported

Configuration, Description and Extension

ctlModel ENUMERATED CF Status-only |
direct-with-
normal-security |
sbo-with-normal-
security | direct-
with-enhanced-
security | sbo-
with-enhanced-
security

M Supported

sboTimeout INT32U CF AC_CO_O Not Supported

sboClass ENUMERATED CF operate-once |
operate-many

AC_CO_O Not Supported

minVal INT8 CF O Not Supported

maxVal INT8 CF O Not Supported

stepSize INT8U CF O Not Supported

d VISIBLE
STRING255

DC Text O Supported

cdcNs VISIBLE
STRING255

EX AC_DLNDA_M Not Supported

cdcName VISIBLE
STRING255

EX AC_DLNDA_M Not Supported

dataNs VISIBLE
STRING255

EX AC_DLN_M Not Supported
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Status-only is supported for the ctlModel.

11.2.2.21. Controllable analogue set point information (APC)

Table 11.2.2.21.-1 defines the common data class of controllable analogue set point
information.

Table 11.2.2.21.-1 Controllable analogue set point (APC)

APC class

Attribute Name Attribute Type FC TrgOp
Value/ Value
range

M/O/C
SPA-ZC 402/
Comments

DataName Inherited from Data Class (refer to IEC 61850-7-2) Not Supported

DataAttribute

Setpoint and measured values

setMag AnalogueValue SP MX dchg M Not Supported

origin Originator SP MX O Not Supported

operTm TimeStamp SP O Not Supported

q Quality ST qchg M Not Supported

t TimeStamp ST M Not Supported

Configuration, Description and Extension

ctlModel ENUMERATED CF direct-with-
normal-security

M Not Supported

units Unit CF see Annex A O Not Supported

sVC ScaledValue-
Config

CF AC_SCAV Not Supported

minVal AnalogueValue CF O Not Supported

maxVal AnalogueValue CF O Not Supported

stepSize AnalogueValue CF 1 ... (maxVal-
minVal)

O Not Supported

d VISIBLE
STRING255

DC Text O Not Supported

cdcNs VISIBLE
STRING255

EX AC_DLNDA_M Not Supported

cdcName VISIBLE
STRING255

EX AC_DLNDA_M Not Supported

dataNs VISIBLE
STRING255

EX AC_DLN_M Not Supported

11.2.2.22. Single point setting (SPG)

Table 11.2.2.22.-1 defines the common data class of single point setting.
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Table 11.2.2.22.-1 Single point setting (SPG)

APC class

Attribute Name Attribute Type FC TrgOp
Value/ Value
range

M/O/C
SPA-ZC 402/
Comments

DataName Inherited from Data Class (refer to IEC 61850-7-2) Not Supported

DataAttribute

Setting

setVal BOOLEAN SP off (FALSE) | on
(TRUE)

AC_NSG_M Not Supported

setVal BOOLEAN SQSE off (FALSE) | on
(TRUE)

AC_SG_M Not Supported

Configuration, Description and Extension

d VISIBLE
STRING255

DC Text O Not Supported

cdcNs VISIBLE
STRING255

EX AC_DLNDA_M Not Supported

cdcName VISIBLE
STRING255

EX AC_DLNDA_M Not Supported

dataNs VISIBLE
STRING255

EX AC_DLN_M Not Supported

11.2.2.23. Integer status setting (ING)

Table 11.2.2.23.-1 defines the common data class of integer status setting.

Table 11.2.2.23.-1 Integer status setting (ING)

APC class

Attribute Name Attribute Type FC TrgOp
Value/ Value
range

M/O/C
SPA-ZC 402/
Comments

DataName Inherited from Data Class (see IEC 61850-7-2) Not Supported

DataAttribute

Setting

setVal INT32 SP AC_NSG_M Not Supported

setVal INT32 SG SE AC_SG_M Not Supported

Configuration, Description and Extension

minVal INT32 CF O Not Supported

maxVal INT32 CF O Not Supported

stepSize INT32 CF 1 … (maxVal -
minVal)

O Not Supported

D VISIBLE
STRING255

DC Text O Not Supported

CdcNs VISIBLE
STRING255

EX AC_DLNDA_M Not Supported

cdcName VISIBLE
STRING255

EX AC_DLNDA_M Not Supported

dataNs VISIBLE
STRING255

EX AC_DLN_M Not Supported
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11.2.2.24. Analogue setting (ASG)

Table 11.2.2.24.-1 defines the common data class of analogue setting.

Table 11.2.2.24.-1 Analogue setting (ASG)

ASG class

Attribute Name Attribute Type FC TrgOp
Value/ Value
range

M/O/C
SPA-ZC 402/
Comments

DataName Inherited from Data Class (refer to IEC 61850-7-2) Not Supported

DataAttribute

Setting

setMag AnalogueValue SP AC_NSG_M Not Supported

setMag AnalogueValue SG SE AC_SG_M Not Supported

Configuration, Description and Extension

units Unit CF see Annex A O Not Supported

sVC ScaledValue-
Config

CF AC_SCAV Not Supported

minVal AnalogueValue CF O Not Supported

maxVal AnalogueValue CF O Not Supported

stepSize AnalogueValue CF 1 … (maxVal -
minVal)

O Not Supported

d VISIBLE
STRING255

DC Text O Not Supported

CdcNs VISIBLE
STRING255

EX AC_DLNDA_M Not Supported

cdcName VISIBLE
STRING255

EX AC_DLNDA_M Not Supported

dataNs VISIBLE
STRING255

EX AC_DLN_M Not Supported

11.2.2.25. Setting curve (CURVE)

Table 11.2.2.25.-1 defines the common data class of setting curve.

Table 11.2.2.25.-1 Setting curve (CURVE)

ASG class

Attribute Name Attribute Type FC TrgOp
Value/ Value
range

M/O/C
SPA-ZC 402/
Comments

DataName Inherited from Data Class (refer to IEC 61850-7-2) Not Supported

DataAttribute

Setting

setCharact ENUMERATED SP AC_NSG_M Not Supported

setParA FLOAT32 SP AC_NSG_O Not Supported

setParB FLOAT32 SP AC_NSG_O Not Supported

setParC FLOAT32 SP AC_NSG_O Not Supported

setParD FLOAT32 SP AC_NSG_O Not Supported

setParE FLOAT32 SP AC_NSG_O Not Supported
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ASG class

Attribute Name Attribute Type FC TrgOp
Value/ Value
range

M/O/C
SPA-ZC 402/
Comments

setParF FLOAT32 SG SE AC_NSG_O Not Supported

setCharact ENUMERATED SG SE AC_NSG_M Not Supported

setParA FLOAT32 SG SE AC_NSG_O Not Supported

setParB FLOAT32 SG SE AC_NSG_O Not Supported

setParC FLOAT32 SG SE AC_NSG_O Not Supported

setParD FLOAT32 SG SE AC_NSG_O Not Supported

setParE FLOAT32 SG SE AC_NSG_O Not Supported

setParF FLOAT32 SG SE AC_NSG_O Not Supported

Configuration, Description and Extension

d VISIBLE
STRING255

DC Text O Not Supported

cdcNs VISIBLE
STRING255

EX AC_DLNDA_M Not Supported

cdcName VISIBLE
STRING255

EX AC_DLNDA_M Not Supported

dataNs VISIBLE
STRING255

EX AC_DLN_M Not Supported

11.2.2.26. Device name plate (DPL)

Table 11.2.2.26.-1 defines the common data class of device name plate.

Table 11.2.2.26.-1 Device name plate (DPL)

ASG class

Attribute Name Attribute Type FC TrgOp
Value/ Value
range

M/O/C
SPA-ZC 402/
Comments

DataName Inherited from Data Class (refer to IEC 61850-7-2) Supported

DataAttribute

Configuration, Description and Extension

vendor VISIBLE
STRING255

DC M Supported

hwRev VISIBLE
STRING255

DC O Supported

swRev VISIBLE
STRING255

DC O Supported

serNum VISIBLE
STRING255

DC O Supported

model VISIBLE
STRING255

DC O Not Supported

location VISIBLE
STRING255

DC O Supported
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ASG class

Attribute Name Attribute Type FC TrgOp
Value/ Value
range

M/O/C
SPA-ZC 402/
Comments

cdcNs VISIBLE
STRING255

EX AC_DLNDA_M Not Supported

cdcName VISIBLE
STRING255

EX AC_DLNDA_M Not Supported

dataNs VISIBLE
STRING255

EX AC_DLN_M Not Supported

11.2.3. Logical node name plate (LPL)

Table 11.2.3.-1 defines the common data class of logical node name plate.

Table 11.2.3.-1 Logical node name plate (LPL)

ASG class

Attribute Name Attribute Type FC TrgOp
Value/ Value
range

M/O/C
SPA-ZC 402/
Comments

DataName Inherited from Data Class (see IEC 61850-7-2) Supported

DataAttribute

Configuration, Description and Extension

vendor VISIBLE
STRING255

DC M Supported

hwRev VISIBLE
STRING255

DC M Supported

d VISIBLE
STRING255

DC Text M Supported

configRev VISIBLE
STRING255

DC AC_LN0_M Supported

ldNs VISIBLE
STRING255

EX must be included
only in LLN0

AC_LN0_M Supported

lnNs VISIBLE
STRING255

EX AC_DLD_M Supported

cdcNs VISIBLE
STRING255

EX AC_DLNDA_M Not Supported

cdcName VISIBLE
STRING255

EX AC_DLNDA_M Not Supported

dataNs VISIBLE
STRING255

EX AC_DLN_M Not Supported

For InNs the value (val) needs to be set after specific short address
(sAddr).
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11.2.3.1. Curve shape description (CSD)

Table 11.2.3.1.-1 defines the common data class of curve shape description.

Table 11.2.3.1.-1 Curve shape description (CSD)

CSD class

Attribute Name
Attribute
Type

FC TrgOp
Value/ Value
range

M/O/C
SPA-ZC 402/
Comments

DataName Inherited from Data Class (refer to IEC 61850-7-2) Not Supported

DataAttribute

Configuration, Description and Extension

xUnit Unit DC M Not Supported

xD VISIBLE
STRING255

DC M Not Supported

yUnit Unit DC M Not Supported

yD VISIBLE
STRING255

DC M Not Supported

numPts INT16U DC M Not Supported

crvPts ARRAY[1..
numPt] OF

M Not Supported

xVal FLOAT32 DC

xVal FLOAT32 DC

d VISIBLE
STRING255

DC M Not Supported

cdcNs VISIBLE
STRING255

EX AC_DLN-
DA_M

Not Supported

cdcName VISIBLE
STRING255

EX AC_DLN-
DA_M

Not Supported

dataNs VISIBLE
STRING255

EX AC_DLN_M Not Supported

11.3. SCL conformance statement

Table 11.3.-1 defines the support of Substation Configuration Language.

Table 11.3.-1 SCL conformance degrees
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SCL conformance Client-CR Server-CR

Base F/S Value/Range Base F/S
SPA-ZC 402/
Comments

SCL.1 SCL File for
Implementa-
tion Available
(offline)

m m Supported, CID
file export

SCL.2 SCL File
available from
implementa-
tion online

O o o o Supported, CID
file can be
retrieved online
with FTP from the
device

SCL.3 SCL
implementa-
tion
reconfiguration
supported
online

O o o o Supporteda)

a) The CID file is used to configure the device. Notice that you have to preserve the SPA-ZC 40x Communication Engineering Tool's (CET)
private sections to configure a device again. CET for SPA-ZC 40x knows product limitations and it is recommended to use only for the
configuration.

Implementations claiming conformance to SCL.2 or SCL.3 may support the ACSI
services defined in Table 11.3.-2.

Table 11.3.-2 Supported ACSI services for SCL.2 and SCL.3

SCL conformance Client-CR Server-CR

Base F/S Value/Range Base F/S
SPA-ZC 402/
Comments

ACSI Services Not Supported

GetFileAttribu-
teValues

O o o m Supported

GetFile O a) o a) Supported

SetFile O b) o b) Supported

DeleteFile O o o b) Supported

GetDataVa-
lues

O c) o c) Not Supported

SetDataVa-
lues

O a) o a) Not Supported

SCL Control
Block

I i o b) Not Supported

SCL File
Structure

I m i m Not Supported

Remote
Creation of
SCL File

I o i o Not Supported

a) Must be m if support for SCL.2 is declared.
b) Must be m if support for SCL.3 is declared.
c) Must be m if support for SCL.2 or SCL.3 is declared.

The additional MMS services, defined Table 11.3.-3, must be supported if support
for SCL.2 or SCL.3 is declared.
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Table 11.3.-3 Additional MMS services for SCL.2 and SCL.3

SCL conformance Client-CR Server-CR

Base F/S Value/Range Base F/S
SPA-ZC 402/
Comments

MMS Services Not Supported

GetCapability-
List

O i o i Supported

GetDomainAt-
tributes

O o o m Not Supported

LoadDomain O a) o a) Not Supported

StoreDomain O b) o b) Not Supported
a) Must be m if support SCL.3 is declared.
b) Must be m if support for remote creation of a SCL is declared.

11.4. SCL control block

The SCL control block must have a functional constraint of SC. This control block
must occur in LLN0 only.

The SCL control block must be a structured MMS type definition that contains the
ordered named components defined in Table 11.4.-1.

Table 11.4.-1 Definition of SCL control block

IEC 61850-8-
1Component
Name

MMS
TypeDescription

r/w m/o Comments SPA-ZC 402/Comments

validate VISIBLE-STRING
size of 64 octets

rw mo Must be m if support for
remote activation of an SCL
is declared.

N/A for TP client

valState Unsigned Integer -
8 bits

r m (0) - NOT-VALIDATED
(1) - VALIDATION-ERROR
(2) - VALIDATED
(3) - VALIDATION-IN-
PROGRESS
(4) - NOT-SUPPORTED
(5) - VALIDATE-FILE-
PRESENT

N/A for TP client

activate VISIBLE-STRING
size of 64 octets

rw mo Must be m if support for
remote activation of an SCL
is declared.

N/A for TP client

11.5. Protocol implementation conformance statement

In the following tables basic protocol conformance statements (PICS) are defined.

11.5.1. Profile conformance
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Table 11.5.1.-1 A-profile support

Client Server
SPA-ZC 402/
Comments

F/S F/S

A1 Client/Server A-
Profile

a) a) Supported

A2 GOOSE/GSE
Management A-
Profile

b) b) Not Supported

A3 GSSE A-Profile c) c) Not Supported

A4 TimeSync A-
Profile

d) d) Supported

a) Must be m if support for any service specified for Client/S are declared within the ACSI basic conformance.
b) Must be m if support for any service specified for GOOSE/GSE Management are declared within the ACSI basic conformance.
c) Must be m if support for any service specified for GSSE A-Profile are declared within the ACSI basic conformance.
d) Support for at least one other A-Profile must be declared (e.g. in A1-A3) in order to claim conformance toIEC 61850-8-1.

Table 11.5.1.-2 A-profile support

Client Server
SPA-ZC 402/
Comments

F/S F/S

T1 TCP/IP T-Profile a) a) Supported

T2 OSI T-Profile b) b) Not Supported

T3 GOOSE/GSE T-
Profile

c) c) Supported

T4 GSSE T-Profile d) d) Not Supported

T5 TimeSync T-
Profile

o o Supported

a) Must be m if support for A1 is declared. Otherwise, must be i.
b) Must be o if support for A1 is declared. Otherwise, must be i.
c) Must be m if support for A2 is declared. Otherwise, must be i.
d) Must be m if support for A3 is declared. Otherwise, must be i.

11.5.1.1. MMS conformance

All needed services supporting the ACSI services stated to be supported in
paragraph 2 are supported by the MMS stack used.

11.5.1.2. GOOSE services

Table 11.5.1.2.-1 below defines the conformance of the GOOSE service.

Table 11.5.1.2.-1 GOOSE conformance

Subscriber Publisher SPA-ZC 402/Comments

GOOSE Services a) a) Supported

SendGOOSEMessage M m Supported

GetGoReference O b) Not Supported

GetGOOSEElementNumber O b) Not Supported

GetGoCBValues O o Not Supported

SetGoCBValues O o Not Supported
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Subscriber Publisher SPA-ZC 402/Comments

GSENotSupported b) c) Not Supported

GOOSE Control Block (GoCB) O o Not Supported
a) Must be m if support is declared within ACSI basic conformance.
b) Must be m if ACSI basic conformance support for either GetGoReference or GetGOOSEElementNumber is declared.
c) Must be m if ACSI basic conformance support for either GetGoReference,GetGOOSEElementNumber, or GOOSE is declared.

Table 11.5.1.2.-2 GSSE conformance

Subscriber Publisher SPA-ZC 402/Comments

GSSE Services a) a) Not Supported

SendGSSEEMessage M m Not Supported

GetGsReference O b) Not Supported

GetGSSEDataOffset O b) Not Supported

GetGsCBValues O o Not Supported

SetGsCBValues O o Not Supported

GSENotSupported b) o Not Supported

GSSE Control Block (GsCB) O o Not Supported
a) Must be m if support is declared within ACSI basic conformance.
b) Must be m if ACSI basic conformance support for either GetGsReference or GetGSSEDataOffset is declared.
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12. KEMA certificate

A060010
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13. Ordering information
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Fig. 13.-1 Ordering information for SPA-ZC 402

SPA-ZC402CD

* SPA-ZC 402 configuration CD
* Engineering tool, Communication Engineering Tool (CET) for SPA-ZC 40x

Order at least one SPA-ZC 402 configuration CD with your delivery to
get the Communication Engineering Tool. The SPA-ZC 402 package
does not include the configuration CD by default.

The Connectivity Packages can be downloaded on the ABB web site
http://www.abb.com/substationautomation.

Select the appropriate product from the Distribution products drop-
down list and click OK. Then select Download tab and from the
Document kind drop-down list, select Software. Finally, click the
Connectivity Package link to download it.

Table 13.-1 Compatibility between IEC 61850 SPA-ZC 402, CET, Connectivity Packages and IEDs

SPA-ZC 40x
version

CET version Connectivity Package versions, devices and release

REX521 1.0 or later REF610 REU610 REM610 SPACOM

Release C, E and F Release G

1.0 1.0 - - - - - -

1.1.1 1.1.1 1.0 or later 1.1 or later 2.0 or later 2.0 or later 2.0 or later -

2.0 2.0 1.0 or later 1.1 or later 2.0 or later 2.0 or later 2.0 or later -

2.1 2.1 2.0 or later 2.0 or later 2.0 or later 2.0 or later 2.0 or later 2.0 or later

2.1.2 2.1.2 2.0 or later 2.0 or later 2.0 or later 2.0 or later 2.0 or later 2.0 or later
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14. Terminology

Term Description

Communication Engineering
Tool

Also known as CET. Software for configuring and monitor-
ing communication gateways or communication front ends.

Functional constraint Property of a data-attribute that indicates the services for
example read value, write value, substitute value, etc. that
may be applied to that data attribute

Intelligent Electronic Device Also known as IED. Devices containing advanced logics
such as meters, protection and control relays and trip units.

Logical Device Representation of a group of functions. Each function is
defined as a logical node. A physical device has one or
several LDs.

RJ-45 Galvanic connector type

sAddr Short Address InformationThe sAddr attribute allows the
allocation of a short address to DO attributes. Short
addresses can be used within the communication to be
more efficient either in the communication, or in the
handling of messages at client or server. Furthermore,
they can be used as IED internal identification for the
attribute.

Snap-in Connector type for plastic fibre cable

SPA Data communication protocol developed by ABB
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15. Abbreviations

Abbreviation Description

ACSI Abstract communication service interface

AR Auto reclosure

CD Change detect; compact disk

CET Communication Engineering Tool

CID Configured IED description

DA Data attribute

DC Direct current

DO Data object

DOI Data object instance

EMC Electromagnetic compatibility

FC Functional constraint

FTP File transfer protocol

GSSE Generic substation status event

HMI Human-machine interface

ICD IED capability description

IED Intelligent electronic device

IP Internet protocol

IRF Internal relay fault

LAN Local area network

LD Logical device

LED Light-emitting diode

LN Logical node

MICS Model implementation conformance statement

MMS Manufacturing message specification

MV Medium voltage

OSI Open System Interconnection

PC Personal computer

PICS Protocol implementation conformance statement

RCB Report Control Block

SCADA Supervision, control and data acquisition

SCL Substation configuration description language (defined by
IEC 61850)

SNTP Simple Network Time Protocol

SPA Data communication protocol developed by ABB

SQL Structured query language

ST Straight-tip; a connector type for fibre optic cable

STP Shielded twisted pair

UTC Universal time clock

XML Extensible markup language
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